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Kurikulum 2013 dirancang untuk memperkuat kompetensi peserta didik dari sisi 
pengetahuan, keterampilan, dan sikap secara utuh. Keutuhan tersebut menjadi 
dasar dalam perumusan kompetensi dasar tiap mata pelajaran, sehingga 
kompetensi dasar tiap mata pelajaran mencakup kompetensi dasar kelompok 
sikap, kompetensi dasar kelompok pengetahuan, dan kompetensi dasar kelompok 
keterampilan. Semua mata pelajaran dirancang mengikuti rumusan tersebut. 

Pembelajaran Dasar-dasar Perbankan untuk Kelas X jenjang SMK Program 
Keahlian Keuangan yang disajikan dalam buku ini juga tunduk pada ketentuan 
tersebut. Dasar-dasar Perbankan bukan berisi materi pembelajaran yang 
dirancang hanya untuk mengasah kompetensi pengetahuan peserta didik. Dasar-
dasar Perbankan adalah mata pelajaran yang membekali peserta didik dengan 
pengetahuan tentang dunia perbankan di Indonesia, keterampilan dalam 
menyajikan pengetahuan yang dikuasainya secara konkret dan abstrak, serta 
dunia perbankan sebagai usaha berdasarkan kepercayaan masyarakat menuntut 
sikap hemat, cermat, disiplin dan jujur. Sehingga dengan belajar dasar-dasar 
perbankan diharapkan terbentuk pola pikir peserta didik yang hemat, cermat, 
disiplin dan jujur. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

KATA PENGANTAR 



 

  

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 
1 

iii 

 
 
KATA PENGANTAR .................................................................................................. ii 
DAFTAR ISI .............................................................................................................. iii 
DAFTAR GAMBAR ................................................................................................... vi 
DAFTAR TABEL ....................................................................................................... ix 
PETA KEDUDUKAN BAHAN AJAR ..........................................................................x 
GLOSARIUM ............................................................................................................. xi 
BAB I PENDAHULUAN............................................................................................. 1 

A. Deskripsi ........................................................................................................ 1 
B. Prasyarat ....................................................................................................... 2 
C. Petunjuk Penggunaan Buku Siswa ............................................................... 3 
D. Tujuan Akhir .................................................................................................. 4 
E. Kompetensi Inti dan Kompetensi Dasar ....................................................... 4 
F. Cek Kemampuan Awal .................................................................................. 9 

BAB II PEMBELAJARAN ........................................................................................ 10 
A. Deskripsi ...................................................................................................... 10 
B. Kegiatan Belajar .......................................................................................... 11 
KEGIATAN BELAJAR 1 MENYIAPKAN DATA AWAL ....................................... 12 

a. Tujuan Pembelajaran ............................................................................... 12 
b. Uraian Materi ............................................................................................ 12 
c. Rangkuman .............................................................................................. 22 
d. Tugas ........................................................................................................ 23 
e. Tes Formatif ............................................................................................. 24 
f. Kunci Jawaban Tes Formatif.................................................................... 27 
g. Lembar Kerja Peserta Didik ..................................................................... 28 

KEGIATAN BELAJAR 2 MEMBUAT DAFTAR AKUN ........................................ 30 
a. Tujuan Pembelajaran ............................................................................... 30 
b. Uraian Materi ............................................................................................ 30 
c. Rangkuman .............................................................................................. 43 
d. Tugas ........................................................................................................ 44 
e. Tes Formatif ............................................................................................. 45 
f. Kunci Jawaban Tes Formatif.................................................................... 48 
g. Lembar Kerja Peserta Didik ..................................................................... 54 

KEGIATAN BELAJAR 3 MENYESUAIKAN PAJAK ........................................... 59 
a. Tujuan Pembelajaran ............................................................................... 59 
b. Uraian Materi ............................................................................................ 59 
c. Rangkuman .............................................................................................. 63 
d. Tugas ........................................................................................................ 64 
e. Tes Formatif ............................................................................................. 65 
f. Kunci Jawaban Tes Formatif.................................................................... 68 
g. Lembar Kerja Peserta Didik ..................................................................... 70 

 
 
 
 
 

DAFTAR ISI 

file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820567
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820568
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820569
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820570
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820571
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820572
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820574
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820573
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820576
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820577
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820578
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820579
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820580
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820581
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820583
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820584
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820587
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820588
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820589
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820590
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820591
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820592
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820593
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820596
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820597
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820598
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820599
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820600
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820601
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820602
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820605
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820606
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820607
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820608
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820609
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820610
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820611


 

 

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 

iv 

KEGIATAN BELAJAR 4 MENGENTRI SALDO AWAL ...................................... 71 
a. Tujuan Pembelajaran ............................................................................... 71 
b. Uraian Materi ............................................................................................ 71 
c. Rangkuman .............................................................................................. 75 
d. Tugas ........................................................................................................ 76 
e. Tes Formatif ............................................................................................. 77 
f. Kunci Jawaban Tes Formatif.................................................................... 80 
g. Lembar Kerja Peserta Didik ..................................................................... 82 

KEGIATAN BELAJAR 5 MENCATAT TRANSAKSI PEMBAYARAN ................. 85 
a. Tujuan Pembelajaran ............................................................................... 85 
b. Uraian Materi ............................................................................................ 85 
c. Rangkuman .............................................................................................. 93 
d. Tugas ........................................................................................................ 94 
e. Tes Formatif ............................................................................................. 95 
f. Kunci Jawaban Tes Formatif.................................................................... 98 
g. Lembar Kerja Peserta Didik ................................................................... 100 

KEGIATAN BELAJAR 6 MENCATAT TRANSAKSI PENERIMAAN ................ 102 
a. Tujuan Pembelajaran ............................................................................. 102 
b. Uraian Materi .......................................................................................... 102 
c. Rangkuman ............................................................................................ 109 
d. Tugas ...................................................................................................... 110 
e. Tes Formatif ........................................................................................... 111 
f. Kunci Jawaban Tes Formatif.................................................................. 114 
g. Lembar Kerja Peserta Didik ................................................................... 116 

KEGIATAN BELAJAR 7 MENCATAT ENTRI PENYESUAIAN ........................ 118 
a. Tujuan Pembelajaran ............................................................................. 118 
b. Uraian Materi .......................................................................................... 118 
c. Rangkuman ............................................................................................ 123 
d. Tugas ...................................................................................................... 124 
e. Tes Formatif ........................................................................................... 125 
f. Kunci Jawaban Tes Formatif.................................................................. 128 
g. Lembar Kerja Peserta Didik ................................................................... 129 

KEGIATAN BELAJAR 8 MENAMPILKAN LAPORAN KEUANGAN ................ 131 
a. Tujuan Pembelajaran ............................................................................. 131 
b. Uraian Materi .......................................................................................... 131 
c. Rangkuman ............................................................................................ 141 
d. Tugas ...................................................................................................... 142 
e. Tes Formatif ........................................................................................... 143 
f. Kunci Jawaban Tes Formatif.................................................................. 146 
g. Lembar Kerja Peserta Didik ................................................................... 153 

KEGIATAN BELAJAR 9 MEMBUAT FILE BACKUP ........................................ 154 
a. Tujuan Pembelajaran ............................................................................. 154 
b. Uraian Materi .......................................................................................... 154 
c. Rangkuman ............................................................................................ 160 
d. Tugas ...................................................................................................... 161 
e. Tes Formatif ........................................................................................... 162 
f. Kunci Jawaban Tes Formatif.................................................................. 164 
g. Lembar Kerja Peserta Didik ................................................................... 166 

 

file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820614
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820615
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820616
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820617
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820618
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820619
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820620
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820623
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820624
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820625
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820626
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820627
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820628
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820629
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820632
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820633
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820634
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820635
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820636
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820637
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820638
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820641
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820642
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820643
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820644
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820645
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820646
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820647
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820650
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820651
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820652
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820653
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820654
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820655
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820656
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820659
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820660
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820661
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820662
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820663
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820664
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820665


 

  

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 
1 

v 

BAB III EVALUASI ................................................................................................ 167 
A. Attitude Skills ............................................................................................. 167 
B. Kognitif Skills ............................................................................................. 168 
C. Psikomotorik Skills .................................................................................... 171 
D. Produk/Benda Kerja Sesuai Kriteria Standar ........................................... 178 
E. Batasan Waktu Yang Telah Ditetapkan .................................................... 178 
F. Kunci Jawaban Kognitif Skill ..................................................................... 179 

BAB IV PENUTUP ................................................................................................ 184 
DAFTAR PUSTAKA .............................................................................................. 185 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820667
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820666
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820670
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820671
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820672
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820674
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820676
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820678
file:///E:/Bahan%20Ajar%20SMK/Hasil%20Akhir/Akuntansi/Komputer%20Akuntansi%20Jilid%201.docx%23_Toc382820680


 

 

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 

vi 

 
 
Gambar: 1. 1 Operator Komputer Akuntansi ............................................................ 1 
Gambar: 1. 2 Paperless ............................................................................................ 1 
Gambar: 1. 3 Proses Komputer Akuntansi ............................................................... 2 
Gambar: 2. 1 Program Master MYOB AccountingPlus 18 ..................................... 13 
Gambar: 2. 2 Penyesuaian format tanggal dan simbol mata uang........................ 15 
Gambar: 2. 3 Mengaktifkan program MYOB .......................................................... 16 
Gambar: 2. 4 Menu Utama ..................................................................................... 16 
Gambar: 2. 5 Identitas Perusahaan ........................................................................ 17 
Gambar: 2. 6 Periode Akuntansi ............................................................................ 17 
Gambar: 2. 7 Pilihan penyusunan Daftar Akun ...................................................... 18 
Gambar: 2. 8 Mengubah nama file dan folder ........................................................ 19 
Gambar: 2. 9 Ubah Nama file dan folder ................................................................ 19 
Gambar: 2. 10 Command Centre ........................................................................... 20 
Gambar: 2. 11 Menu Company Information ........................................................... 21 
Gambar: 2. 12 Company Information RID .............................................................. 21 
Gambar: 2. 13 Company Information RIOD ........................................................... 27 
Gambar: 2. 14 Mengimport Daftar Akun ................................................................ 32 
Gambar: 2. 15 Memilih field-field yang diimport ..................................................... 33 
Gambar: 2. 16 Setup linked Sales Accounts .......................................................... 34 
Gambar: 2. 17 Linked account untuk Purchases ................................................... 34 
Gambar: 2. 18 Setup linked account untuk payroll ................................................ 35 
Gambar: 2. 19 Setup linked account untuk Accounts and Banking Accounts....... 36 
Gambar: 2. 20 Easy Setup Assistant...................................................................... 37 
Gambar: 2. 21 Menghapus akun ............................................................................ 37 
Gambar: 2. 22 Meng-edit akun ............................................................................... 38 
Gambar: 2. 23 Meng-edit akun ............................................................................... 39 
Gambar: 2. 24 Daftar akun kelompok Asset .......................................................... 39 
Gambar: 2. 25 Daftar akun kelompok Liability ....................................................... 40 
Gambar: 2. 26 Daftar akun kelompok Equity ......................................................... 40 
Gambar: 2. 27 Daftar akun kelompok Income........................................................ 40 
Gambar: 2. 28 Daftar akun kelompok Cost of Sales .............................................. 41 
Gambar: 2. 29 Daftar akun kelompok Expense ..................................................... 41 
Gambar: 2. 30 Daftar akun kelompok Other Income ............................................. 42 
Gambar: 2. 31 Daftar akun kelompok Other Expense ........................................... 42 
Gambar: 2. 32 Kelompok Asset .............................................................................. 49 
Gambar: 2. 33 Kelompok Liability ........................................................................... 50 
Gambar: 2. 34 Kelompok Equity ............................................................................. 50 
Gambar: 2. 35 Kelompok Income ........................................................................... 51 
Gambar: 2. 36 Kelompok Cost of Sales ................................................................. 51 
Gambar: 2. 37 Kelompok Expense ......................................................................... 52 
Gambar: 2. 38 Kelompok Other Income ................................................................. 53 
Gambar: 2. 39 Kelompok Other Expense .............................................................. 53 
Gambar: 2. 40 Daftar pajak di Australia ................................................................. 61 
Gambar: 2. 41 Menghapus jenis Pajak PRI. .......................................................... 61 
Gambar: 2. 42 Mengedit GST menjadi PPN .......................................................... 62 

DAFTAR GAMBAR 



 

  

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 
1 

vii 

Gambar: 2. 43 Daftar Pajak yang disesuaian......................................................... 69 
Gambar: 2. 44 Penyesuaian PPN .......................................................................... 69 
Gambar: 2. 45 Menu Entri Saldo Awal ................................................................... 72 
Gambar: 2. 46 Setup Account Opening Balances ................................................. 73 
Gambar: 2. 47 Account Opening Balances ............................................................ 73 
Gambar: 2. 48 Account Opening Balances ............................................................ 74 
Gambar: 2. 49 Neraca yang seimbang................................................................... 74 
Gambar: 2. 50 Neraca Saldo Rio Interior Design ................................................... 81 
Gambar: 2. 51 Neraca Saldo Kasus 1 Renata Interior Designer ........................... 83 
Gambar: 2. 52 Menu untuk mencatat transaksi pembayaran ................................ 86 
Gambar: 2. 53 Menu Banking – Spend Money ...................................................... 87 
Gambar: 2. 54 Pembayaran dengan Cek ............................................................... 87 
Gambar: 2. 55 Recap jurnal pembayaran dengan cek .......................................... 88 
Gambar: 2. 56 Seting Petty Cash ........................................................................... 89 
Gambar: 2. 57 Pembayaran dengan petty cash .................................................... 89 
Gambar: 2. 58 Recap jurnal pembayaran dengan petty cash. .............................. 90 
Gambar: 2. 59 Seting Bank card. ........................................................................... 91 
Gambar: 2. 60 Pembayaran dengan BankCard ..................................................... 91 
Gambar: 2. 61 Menu melihat jurnal pembayaran ................................................... 92 
Gambar: 2. 62 Melihat jurnal Pembayaran ............................................................. 92 
Gambar: 2. 63 Jurnal pembayaran kasus 5.2 ........................................................ 99 
Gambar: 2. 64 Menu untuk mencatat transaksi penerimaan ............................... 103 
Gambar: 2. 65 Menu transaksi penerimaan ......................................................... 104 
Gambar: 2. 66 Deposit to account Cash Drawer ................................................. 104 
Gambar: 2. 67 Data Transaksi Penerimaan tunai ................................................ 105 
Gambar: 2. 68 Recap jurnal penerimaan. ............................................................ 105 
Gambar: 2. 69 Menu Banking – Receive Money ................................................. 106 
Gambar: 2. 70 Deposit to account BCA Account ................................................. 106 
Gambar: 2. 71 Data transaksi penerimaan cek .................................................... 107 
Gambar: 2. 72 Recap jurnal penerimaan cek ...................................................... 107 
Gambar: 2. 73 Menu melihat jurnal penerimaan .................................................. 108 
Gambar: 2. 74 Jurnal penerimaan dari kasus 1 ................................................... 108 
Gambar: 2. 75 Jurnal penerimaan dari Kasus 2 .................................................. 115 
Gambar: 2. 76 Menu untuk pencatatan entri penyesuaian .................................. 119 
Gambar: 2. 77 Langkah 1, klik account dan record Journal entry ....................... 120 
Gambar: 2. 78 Pencatatan entri penyesuaian. ..................................................... 120 
Gambar: 2. 79 Recap Jurnal penyesuaian ........................................................... 121 
Gambar: 2. 80 Menu memeriksa jurnal penyesuaian .......................................... 122 
Gambar: 2. 81 Jurnal penyesuaian Kasus 1 ........................................................ 122 
Gambar: 2. 82 Jurnal penyesuaian Kasus 2 ........................................................ 128 
Gambar: 2. 83 Menu Report ................................................................................. 133 
Gambar: 2. 84 Langkah menyiapkan laporan Laba-Rugi .................................... 134 
Gambar: 2. 85 Laporan Laba Rugi Kasus 1 ......................................................... 134 
Gambar: 2. 86 Langkah menyiapkan laporan Neraca ......................................... 135 
Gambar: 2. 87 Laporan Neraca Kasus 1 .............................................................. 135 
Gambar: 2. 88 Langkah menyiapkan laporan Arus Kas. ..................................... 136 
Gambar: 2. 89 Laporan Arus Kas Kasus 1 ........................................................... 136 
Gambar: 2. 90 Menu Report ................................................................................. 137 
Gambar: 2. 91 Langkah menyiapkan Jurnal Pengeluaran................................... 137 



 

 

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 

viii 

Gambar: 2. 92 Jurnal Pengeluaran Kasus 1 ........................................................ 138 
Gambar: 2. 93 Jurnal Penerimaan Kas Kasus 1 .................................................. 139 
Gambar: 2. 94 Langkah menyiapkan Jurnal Umum............................................. 140 
Gambar: 2. 95 Jurnal Umum Kasus 1 .................................................................. 140 
Gambar: 2. 96 Laporan Laba-Rugi Kasus 2......................................................... 147 
Gambar: 2. 97 Laporan Neraca Kasus 2 .............................................................. 148 
Gambar: 2. 98 Laporan Arus Kas Kasus 2 ........................................................... 149 
Gambar: 2. 99 Jurnal Pengeluaran Kas Kasus 2 ................................................. 150 
Gambar: 2. 100 Jurnal Penerimaan Kas Kasus 2 ................................................ 151 
Gambar: 2. 101 Jurnal Umum Kasus 2 ................................................................ 152 
Gambar: 2. 102 Menu membuat file backup ........................................................ 155 
Gambar: 2. 103 Memilih menu file > Backup ....................................................... 156 
Gambar: 2. 104 Penentuan pilihan file backup .................................................... 156 
Gambar: 2. 105 Penentuan media penyimpanan dan nama file backup............. 157 
Gambar: 2. 106 Menu untuk me-restore backup file ............................................ 158 
Gambar: 2. 107 Pilih nama backup file yang di restore ....................................... 158 
Gambar: 2. 108 Beri Pilih nama file restore ......................................................... 159 
Gambar: 2. 109 Konfirmasi nama file restore....................................................... 159 
Gambar: 2. 110 File backup Kasus 2 ................................................................... 164 
Gambar: 2. 111 File Restore Kasus 2 .................................................................. 165 
Gambar: 3. 1 Laporan Laba-rugi .......................................................................... 181 
Gambar: 3. 2 Laporan Neraca .............................................................................. 182 
Gambar: 3. 3 Laporan Arus Kas ........................................................................... 183  
Gambar: 4. 1 Start a New Financial Year ............................................................. 184 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

  

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 
1 

ix 

 
 
Tabel: 2- 1 Tipe-tipe Akun ...................................................................................... 31 
Tabel: 2- 2 Daftar Akun ........................................................................................... 57 
Tabel: 2- 3 Daftar Akun ........................................................................................... 57 
Tabel: 2- 4 Daftar Akun ........................................................................................... 58 
Tabel: 2- 5 Neraca Saldo Renata Interior Designer ............................................... 82 
Tabel: 2- 6 Neraca Saldo Rio Interior Design......................................................... 84 
Tabel: 2- 7 Transaksi pengeluaran kas dengan cek kasus 5.1 ........................... 100 
Tabel: 2- 8 Transaksi Pengeluaran Kas Kecil kasus 5.1 ..................................... 100 
Tabel: 2- 9 Transaksi Pembayaran dengan Bankcard kasus 5.1 ........................ 100 
Tabel: 2- 10 Transaksi Pengeluaran dengan Kas Kecil Kasus 5.2 ..................... 101 
Tabel: 2- 11 Transaksi Pengeluaran dengan Bankcard Kasus 5.2 ..................... 101 
Tabel: 2- 12 Transaksi penerimaan kas dari kasus 1. ......................................... 116 
Tabel: 2- 13 Transaksi penerimaan cek dari kasus 1. ......................................... 116 
Tabel: 2- 14 Transaksi penerimaan kas dari kasus 2. ......................................... 117 
Tabel: 2- 15 Transaksi penerimaan cek dari kasus 2. ......................................... 117 
Tabel: 2- 16 Entri Penyesuaian Kasus 1 .............................................................. 129 
Tabel: 2- 17 Entri Penyesuaian Kasus 2 .............................................................. 130 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DAFTAR TABEL 



 

 

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 

x 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

Pengantar Ekonomi dan 
Bisnis 
(C1-1) 

 

Pengantar Akuntansi 
dan Keuangan 

(C1-3) 
 

Pengantar Administrasi 
Perkantoran 

 (C1-2) 
 

Etika Profesi 
 (C2-2) 

 

Simulasi Digital 
(C2-1) 

 

Akuntansi Perusahaan 
Jasa  

(C2-5) 
 

Dasar-Dasar Perbankan 
 (C1-3) 

 

Paket Pengolah Angka 
 (C2-2) 

 

Akuntansi Perusahaan 
Dagang 
(C3-1) 

 

Komputer Akuntansi 
 (C3-3) 

 

Administrasi Pajak 
 (C3-5) 

 

Administrasi Perusahaan 
Manufaktur 

 (C3-4) 
 

Akuntansi Keuangan 
 (C3-2) 

 

PETA KEDUDUKAN BAHAN AJAR 



 

  

Direktorat Pembinaan SMK (2013) 

Komputer Akuntansi Jilid 1 
1 

xi 

 

Akun (account) Disebut juga rekening atau perkiraan adalah 
formulir untuk mencatat secara indivual tentang 
penambahan atau pengurangan tiap jenis harta, 
kewajiban, dan ekuitas. 

Account  
Receivable (Trade 
Debtor) 

Piutang Dagang, yaitu tagihan kepada para 
pelanggan karena adanya trasaksi penjualan 

Account Payable 
(Trade Creditor) 

Utang Dagang, yaitu kewajiban perusahaan yang 
harus dibayar perusahaan karena danya transaksi 
pembelian. 

Akuntansi Suatu proses yang meliputi kegiatan 
pengidentifikasian, pencatatan, pengikhtisaran dan 
pelaporan data keuangan. 

Aplikasi Komputer 
Akuntansi 

Program terintegrasi yang disusun untuk penerapan 
sistem komputerisasi di bidang akuntansi. 

Asset Aset atau Aktiva, yaitu seluruh kekayaan yang 
dimiliki oleh perusahaan 

Bagan akun (chart 
of account) 

Daftar akun dan nomor kodenya yang 
mengidentifikasi tempatnya dalam buku besar. 

Balance Sheet Neraca, yaitu merupakan salah satu laporan 
keuangan yang memberikan informasi mengenai 
aset, kewajiban dan ekuitas. 

Building Gedung (Bangunan), yaitu salah satu aset tetap 
yang dimiliki oleh perusahaan. 

Buku besar 
(ledger) 

Buku yang berisi akun-akun harta, kewajiban, dan 
ekuitas atau kumpulan dari kartu-kartu akun. 

Cash Flow 
Statement 

Laporan Arus Kas, yaitu salah satu laporan 
keuangan yang memberikan informasi tentang 
aliran kas masuk dan kas keluar dari kegiatan 
operasi, investasi dan pendanaan. 

Cash on Hand Jumlah kas yang dimiliki oleh perusahaan.  

Card File File Kartu, yaitu kartu untuk mencatat informasi 
setiap pelanggan dan pemasok (Customers and 
Suppliers) 

Cheque Book Buku Cek, kumpulan cek yang siap untuk diisi dan 
digunakan untuk pembayaran. 

Current Asset Aktiva Lancar, yaitu kelompok aset yang 
perputarannya dalam jangka pendek (kurang dari 
satu tahun). 

Current Liabilities Kewajiban Lancar (Utang Lancar), yaitu salah satu 

GLOSARIUM 
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bentuk kewajiban yang harus dituaikan dalam waktu 
satu tahun atau kurang. 

Command Centre 
Account 

Pusat kendali pada MYOB yang berfungsi untuk 
pembuatan daftar akun,  pencatatan saldo awal 
buku besar, pembuatan jurnal umum, posting dan 
laporan keuangan. 

Command Centre 
Banking 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat penerimaan uang yang bukan bersumber 
dari pelunasan piutang dan pengeluaran cek  yang 
bukan untuk pembayaran utang. 

Command Centre 
Sales 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
penjualan, retur penjualan dan pelunasan piutang 
serta menyajikan laporan yang berhubungan 
dengan penjualan, misalnya rekap penjualan per 
item atau per costumer, analisis piutang dan 
sebagainya. 

Command Centre 
Purchases 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
pembelian, retur pembelian dan pembayaran utang 
serta menyajikan laporan yang berhubungan 
dengan pembelian, misalnya rekap pembelian per 
item atau per supplier. 

Command Centre 
Inventory 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat item barang yang dibeli untuk dijual, 
penggabungan komponen menjadi satu unit barang 
baru atau sebaliknya, menyajikan laporan yang 
berkaitan dengan persediaan. 

Command Centre 
Card 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat data pelanggan (customer) dan pemasok 
(supplier) baik yang berkaiatan dengan nama, 
alamat, saldo awal piutang, utang, dan informasi 
lainnya. 

Debit Sisi sebelah kiri suatu akun. 

Deposit paid  Uang Muka atau uang panjar yang dibayarkan 
kepada supplier 

Double entry 
system 

Sistem pencatatan dari efek ganda (dual effect) dari 
tiap transaksi secara tepat. 

Electric Expense Beban Listrik 

Equipment Peralatan, salah satu jenis aset tetap. 

Equity Ekuitas atau modal 

Expenses Beban-beban operasi atau non operasi perusahaan. 

Fixed Asset Aktiva Tetap, yaitu aset yang umurn pemakaiannya 
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lebih dari satu tahun. 

Furniture Meubel, yaitu termasuk salah satu jenis aset tetap 
perusahaan. 

General Ledger Buku Besar, yaitu kumpulan akun-akun. 

General Journal 
Entry 

Formulir  untuk mencatat Jurnal Umum 

Income Penghasilan (Pendapatan) 

Interest Expense Beban Bunga, yaitu beban non operasi perusahaan 

Interest Revenue Pendapatan Bunga, salah satu pendapatan yang 
termasuk dalam non operasi 

Jurnal Buku catatan akuntansi yang digunakan untuk 
mencatat transaksi-transaksi keuangan yang terjadi 
setiap hari. 

Jurnal umum Bentuk jurnal yang paling umum dipakai untuk 
mencatat semua jenis transaksi. 

Kredit (credit) Sisi kanan suatu akun. 

Laporan Keuangan Merupakan ringkasan dari transaksi-transaksi 
keuangan yang terjadi selama satu periode 
akuntansi tertentu 

Liability Kewajiban, yaitu sesuatu yang harus ditunaikan 
perusahaan. 

MYOB Salah satu aplikasi komputer akuntansi yang dibuat 
oleh salah satu perusahaan di Australia yang 
merupakan singkatan dari Mind on Your Own 
Business. 

Neraca saldo (trial 
balance) 

Daftar akun-akun buku-buku dan saldo-saldonya 
pada saat tertentu. 

 

Motor vehicle Kendaraan Bermotor, yaitu salah satu jenis aset 
tetap 

Office supplies Suplies Kantor atau Bahan Habis Pakai (BHP) 

Other Expense Beban lain-lain di luar opersai perusahaan. 

Payroll Check Cek Gaji, yaitu cek yang khusus untuk pembayaran 
gaji. 

 

Periode Akuntansi Rentangan waktu akuntansi yang dimulai pada saat 
pembuatan neraca awal sampai dengan saat 
pembuatan laporan keuangan, biasanya selama 
satu tahun.  

Perusahaan Jasa Entitas bisnis yang usaha pokoknya memperoleh 
pendapatan dengan memberikan layanan jasa 
kepada pelanggan 
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Posting Prosedur memasukkan/memindahkan data dari 
jurnal ke buku besar. 

Profit and Loss 
Report 

Laporan Laba Rugi, salah satu jenis laporan yang 
memberikan informasi tentang pendapatan 
dibandingkan dengan beban-beban perusahaan. 

Provision for 
doubtful debt 

Cadangan kerugian piutang, dana yang disediakan 
untuk menutup kerugian akibat piutang yang tidak 
tertagih. 

Telephone 
Expense 

Beban Telepon, yaitu pembayaran tagihan rekening 
telkom. 

Transaksi 
Keuangan 

Kegiatan ekonomis yang dilakukan oleh 
perusahaan yang secara financial berdampak pada 
perubahan posisi keuangannya. 

Transaction 
Journal 

Jurnal Transaksi, yaitu catatan hasil pemrosesan 
jurnal transaksi keuangan tertentu. 

Trial Balance Neraca Saldo, yaitu selisih antara jumlah debit dan 
jumlah kredit akun-akun yang ada dalanm buku 
besar. 

Other Income Penghasilan Lain-lain di luar usaha pokok 
perusahaan. 

Rent Expense Beban Sewa, yaitu pembayaran sewa 
gedung/peralatan. 

Retained Earning Laba Ditahan, yaitu sebagian laba yang tidak 
dibagikan kepada pemilik perusahaan. 

Salaries and Wage 
Expenses 

Beban Gaji dan Upah, yaitu pembayaran gaji/upah 
pegawai bulanan. 

Water Expense Beban air, yaitu pembayaran tagihan rekening PAM 
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A. Deskripsi 
 
 
 

 

 

Perkembangan teknologi komputer telah memicu lembaga bisnis untuk 
menerapkan sistem informasi di segala bidang, termasuk bidang akuntansi. 
Penerapan komputer di bidang akuntansi ini semakin luas berkembang 
dikarenakan banyaknya software aplikasi komputer akuntansi yang tersedia di 
masyarakat. Justru permasalahan pokok yang dihadapi oleh lembaga bisnis 
adalah kurang tersedianya tenaga kerja yang kompeten dalam pengoperasian 
komputerisasi akuntansi. 

 

Gambar: 1. 1 Operator Komputer Akuntansi 

Tidak jarang lembaga bisnis harus 
mengeluar-kan biaya pelatihan yang 
cukup besar untuk menyiapkan tenaga 
operator komputer akuntansi. Sekolah 
Menengah Kejuru-an (SMK) sebagai 
salah satu lembaga penyedia calon 
tenaga kerja tingkat menengah tanggap 
terha-dap tuntutan industri.            

Dalam kurikulum 2013 khususnya 
untuk paket keahlian akuntansi peserta 
didik dituntut memiliki kemampuan 
menerapkan pengetahuan, 
keterampilan dan sikap yang konsisten 
dari waktu ke waktu dalam 
pengoperasian aplikasi komputer 
akuntansi. Sebagian kompetensi dasar 
dalam mata pelajaran Komputer 
Akuntansi menuntut peserta diklat 
untuk menguasai kompetensi secara 
utuh mengoperasikan aplikasi 
komputer akuntansi pada perusahaan 
jasa. Apakah perusahaan jasa itu? 
Perusahaan jasa adalah perusahaan 
yang usaha pokoknya ditujukan untuk 
memperoleh pendapatan atau 
penghasilan melalui pelayanan jasa 
tertentu.  

Keuntungan menerapkan komputer akuntansi pada perusahaan jasa diantaranya 
adalah mengurangi penggunaan kertas-kertas (paperless) sehingga pada 
gilirannya akan mengurangi beban alat tulis kantor (atk) atau beban perlengkap-an 
(supplies). Disamping itu keuntungan penerapan komputer di bidang akuntansi 
adalah jaminan untuk kecepatan dan ketepatan. 

 
Gambar: 1. 2 Paperless 

BAB I 

PENDAHULUAN 
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Kecepatan karena sebagian besar pekerjaan akuntansi diambil alih oleh komputer 
dan dikerjakan dengan cepat. 

 

 

 

 

 
 
 
 
 
 
 

 

Gambar: 1. 3 Proses Komputer Akuntansi 

Tugas operator hanyalah sebatas data entri, sementara tugas selanjutnya 
termasuk penyusunan laporan keuangan dikerjakan oleh komputer. Selama data 
yang dientri ke komputer data yang benar maka maka hasilnyapun akan benar 
atau tepat. 

Aktivitas komputer akuntansi perusahaan jasa mengarah pada data entri transaksi 
keuangan yang terjadi pada perusahaan jasa sejak awal periode sampai dengan 
proses penyiapan laporan keuangan pada akhir periode akuntansi. Aktivitas ini 
secara keseluruhan meliputi: 

1. Menyiapkan data awal; 

2. Membuat daftar akun; 

3. Menyesuaikan pajak; 

4. Meng-entry saldo awal; 

5. Mencatat Kas Keluar; 

6. Mencatat Kas Masuk; 

7. Mencatat entri penyesuaian; 

8. Menampilkan laporan keuangan. 

9. Membuat backup file. 

 
 
 
 
Untuk memudahkan peserta didik dalam mempelajari buku ini, 
maka terlebih dahulu dipersyaratkan telah menguasai kompetensi 
dasar yang ada dalam mata pelajaran: 

1. Pengantar Akuntansi dan Keuangan 
2. Akuntansi Perusahaan Jasa. 

B. Prasyarat 
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Buku Komputer Akuntansi 1 disusun untuk peserta didik, guna mendukung mata 
pelajaran Komputer Akuntansi di kelas XI semester I pada paket keahlian 
Akuntansi. 

Dalam buku ini terdapat 9 (sembilan) kegiatan belajar. Disarankan kepada peserta 
didik untuk mempelajari buku ini secara urut agar lebih mudah memahaminya.  

Agar aktivitas peserta didik lebih terarah dan lebih lancar dalam pencapaian 
kompetensi maka disarankan untuk mengikuti petunjuk-petunjuk berikut ini: 

1. Bacalah dengan cermat peta kedudukan modul, prasyarat dan pengertian 
dari istilah-istilah penting dalam buku ini. 

2. Untuk setiap kegiatan belajar, bacalah dengan cermat rumusan tujuan 
pembelajaran yang memuat pengetahuan dan kinerja yang diharapkan 
dalam rangka membentuk kompetensi kerja yang akan dicapai melalui 
modul ini.  

3. Pahami dengan baik uraian materi pada setiap kegiatan belajar termasuk 
kasus yang diberikan. Diskusikan dengan sesama peserta didik, uraian atau 
bagian dari kasus yang sulit dipahami. Bila masih ragu, maka tanyakanlah 
pada guru  sampai paham. 

4. Ikuti langkah-langkah pemecahan kasus seperti yang tertulis di setiap 
kegiatan belajar. Lakukan ini bersama-sama dalam kelompok kecil. Bila 
mengalami kesulitan diskusikan dengan anggota kelompok. Jika masih ragu, 
maka tanyakanlah pada guru  sampai jelas. 

5. Kerjakan tugas-tugas, dan jawablah pertanyaan tes, kemudian cocokkan 
dengan kunci jawaban. Lakukan kegiatan ini sampai peserta didik tuntas 
menguasai hasil belajar yang diharapkan. 

6. Setelah kamu menuntaskan satu kegiatan belajar selanjutnya pelajari 
kegiatan belajar berikutnya secara urut. 

7. Peserta didik tidak dibenarkan melanjutkan pada kegiatan belajar 
berikutnya, bila belum menguasai secara tuntas materi pada kegiatan 
belajar sebelumnya. 

8. Setelah semua kegiatan belajar tuntas dipelajari maka ajukan diri untuk 
melaksanakan evaluasi penyelesaian buku 1.  

Pelaksanaan evaluasi ini bisa dikerjakan secara individu atau klasikal. Jika 
hasilnya memuaskan dapat melanjutkan kegiatan belajar di buku 2. 

 

 

 

 

 

 

C. Petunjuk Penggunaan Buku Siswa 
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Spesifikasi kompetensi yang diharapkan dikuasai 
setelah menyelesaikan kegiatan belajar ini adalah 
dengan diberikan kasus-kasus akuntansi perusahaan 
jasa peserta didik dapat menyelesaikan proses 
komputer akuntansi sampai dengan akhir periode, 
sehingga dapat menghasilkan laporan keuangan 
sesuai dengan permintaan. 

 
 
 
 

 

Tabel berikut ini menyajikan kompetensi inti dan kompetensi dasar untuk mata 
pelajaran Komputer Akuntansi di  kelas XI. 

KOMPETENSI  INTI KOMPETENSI  DASAR 

1. Menghayati dan 
mengamalkan ajaran agama 
yang dianutnya  

 

1.1 Mensyukuri  karunia Tuhan Yang Maha 
Esa, atas pemberian amanah untuk 
mengelola administrasi keuangan entitas.  

1.2 Mengamalkan ajaran agama dalam 
memanfaatkan ilmu pengetahuan dan 
teknologi untuk menghasilkan informasi 
keuangan yang mudah dipahami, 
relevan, andal dan dapat 
diperbandingkan. 

2. Menghayati dan 
mengamalkan perilaku jujur, 
disiplin, tanggungjawab, 
peduli (gotong royong, 
kerjasama, toleran, damai), 
santun, responsif dan pro-
aktif dan menunjukkan sikap 
sebagai bagian dari solusi 
atas berbagai permasalahan 
dalam berinteraksi secara 
efektif dengan lingkungan 
sosial dan alam serta dalam 
menempatkan diri sebagai 
cerminan bangsa dalam 
pergaulan dunia 

2.1. Memiliki motivasi internal dan 
menunjukkan rasa ingin tahu dalam 
menemukan dan memahami 
pengetahuan dasar tentang komputer 
akuntansi. 

2.2. Menunjukkan perilaku jujur, disiplin, 
tanggungjawab, santun, responsif dan 
pro-aktif dalam berinteraksi secara efektif 
dalam lingkungan sosial sesuai dengan 
prinsip etika profesi bidang komputer 
akuntansi. 

2.3. Menghargai kerja individu dan kelompok 
serta mempunyai kepedulian yang tinggi 
dalam menjaga keselarasan lingkungan 
sosial, lingkungan kerja dan alam. 

 

D. Tujuan Akhir 

E. Kompetensi Inti dan Kompetensi Dasar 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

3. Memahami dan menerapkan 
pengetahuan faktual, 
konseptual, dan  prosedural, 
berdasarkan rasa ingin 
tahunya tentang ilmu 
pengetahuan, teknologi, 
seni, budaya, dan humaniora 
dengan wawasan 
kemanusiaan, kebangsaan, 
kenegaraan, dan peradaban 
terkait penyebab fenomena 
dan kejadian dalam bidang 
kerja yang spesifik untuk 
memecahkan masalah.  

 

3.1. Mendeskripsikan spesifikasi sistem 
komputer yang diperlukan untuk 
menginstal program aplikasi komputer 
akuntansi yang dipilih. 

3.2. Mendeskripsikan proses pembuatan file 
data akuntansi baru untuk perusahaan 
jasa   

3.3. Menganalisis susunan daftar akun dan 
hubungan akun (link accounts) untuk 
komputerisasi akuntansi perusahaan 
jasa  

3.4. Mendeskripsikan cara penyesuaian 
pajak pertambahan nilai (PPN) untuk 
perusahaan jasa 

3.5. Mendeskripsikan cara pengisian saldo 
awal akun buku besar perusahaan jasa  

3.6. Menganalisis transaksi-transaksi 
pengeluaran kas/bank pada perusahaan 
jasa dan cara pengentriannya. 

3.7. Menganalisis transaksi-transaksi 
penerimaan kas/bank pada perusahaan 
jasa dan cara pengentriannya. 

3.8. Menjelaskan penyelesaian rekonsiliasi 
bank untuk perusahaan jasa  

3.9. Menganalisis  transaksi umum  termasuk 
transaksi penyesuaian dan cara 
pengentriannya ke dalam buku jurnal 
umum perusahaan jasa 

3.10. Mendeskripsikan cara penyusunan 
laporan keuangan untuk perusahaan 
jasa  

3.11. Mendeskripsikan cara pembuatan file 
backup untuk perusahaan jasa  

3.12. Mendeskripsikan proses pembuatan file 
data akuntansi baru untuk perusahaan 
dagang  

3.13. Menganalisis susunan daftar akun dan 
hubungan akun (link accounts) untuk 
komputerisasi akuntansi perusahaan 
dagang 

3.14. Mendeskripsikan cara penyesuaian 
pajak pertambahan nilai (PPN) untuk 
perusahaan dagang 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

3.15. Mendeskripsikan cara pengisian saldo 
awal akun buku besar perusahaan 
dagang 

3.16. Mendeskripsikan cara  pembuatan kartu 
piutang dan pengisian saldonya untuk 
perusahaan dagang 

3.17. Mendeskripsikan cara  pembuatan kartu 
utang dan pengisian saldonya untuk 
perusahaan dagang 

3.18. Mendeskripsikan cara  pembuatan kartu 
perlengkapan/persediaan dan pengisian 
saldonya untuk perusahaan dagang 

3.19. Mendeskripsikan cara pembuatan kartu 
aktiva tetap dan pengisian saldonya 
untuk perusahaan jasa dan dagang 

3.20. Menganalisis transaksi-transaksi 
pembelian tunai dan pembelian kredit 
pada perusahaan dagang serta cara 
pengentriannya. 

3.21. Menganalisis transaksi-transaksi 
pembayaran utang bagi perusahaan 
dagang dan cara pengentriannya. 

3.22. Menganalisis transaksi-transaksi 
penjualan bagi perusahaan dagang dan 
cara pengentriannya. 

3.23. Menganalisis transaksi-transaksi 
pelunasan piutang bagi perusahaan 
dagang dan cara pengentriannya. 

3.24. Menganalisis transaksi-transaksi 
pengeluaran kas/bank bagi perusahaan 
dagang dan cara pengentriannya. 

3.25. Menganalisis transaksi-transaksi 
penerimaan kas/bank bagi perusahaan 
dagang dan cara pengentriannya. 

3.26. Mendeskripsikan cara penyelesaian 
rekonsiliasi bank untuk perusahaan 
dagang 

3.27. Menganalisis transaksi umum termasuk 
transaksi penyesuaiann dan cara 
pengentriannya ke dalam buku jurnal 
umum perusahaan dagang 

3.28. Mendeskripsikan cara penyusunan 
laporan keuangan untuk perusahaan 
dagang 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

3.29. Mendeskripsikan cara pembuatan file 
backup untuk perusahaan dagang 

4. Mengolah, menalar, dan 
menyaji dalam ranah konkret 
dan ranah abstrak  terkait 
dengan pengembangan dari 
yang dipelajarinya di sekolah 
secara mandiri, dan mampu 
melaksanakan tugas spesifik 
di bawah pengawasan 
langsung.  

 

 

4.1. Menginstal program aplikasi komputer 
akuntansi pada sistem komputer yang 
telah dipersiapkan. 

4.2. Membuat file data akuntansi baru untuk 
perusahaan jasa   

4.3. Menyusun daftar akun dan hubungan 
akun (link accounts) untuk perusahaan 

jasa  

4.4. Menyesuaikan seting pajak 
pertambahan nilai (PPN) untuk 
perusahaan jasa 

4.5. Mengsisi saldo awal akun buku besar 
perusahaan jasa  

4.6. Mengentri transaksi-transaksi 
pengeluaran kas/bank pada perusahaan 
jasa  

4.7. Mengentri transaksi-transaksi 
penerimaan kas/bank pada perusahaan 
jasa 

4.8. Membuat rekonsiliasi bank untuk 
perusahaan jasa  

4.9. Mengentri  transaksi umum  termasuk 
transaksi penyesuaian ke dalam buku 
jurnal umum perusahaan jasa 

4.10. Membuat laporan keuangan untuk 
perusahaan jasa  

4.11. Membuat file backup untuk perusahaan 
jasa  

4.12. Membuat file data akuntansi baru untuk 
perusahaan dagang  

4.13. Membuat  daftar akun dan hubungan 
akun buku besar perusahaan dagang. 

4.14. Menyesuaikan seting pajak 
pertambahan nilai (PPN) untuk 
perusahaan dagang 

4.15. Mengentri saldo awal akun-akun buku 
besar untuk perusahaan dagang 

4.16. Membuat kartu piutang dan mengisi 
saldonya untuk perusahaan dagang 

4.17. Membuat kartu utang dan mengisi 
saldonya perusahaan dagang 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

4.18. Membuat kartu perlengkapan/ 
persediaan dan mengisi saldonya untuk 
perusahaan dagang 

4.19. Membuat kartu aktiva tetap dan mengisi 
saldonya untuk perusahaan dagang 

4.20. Mengentri transaksi-transaksi pembelian 
tunai dan kredit bagi perusahaan 
dagang 

4.21. Mengentri transaksi-transaksi 
pembayaran utang bagi perusahaan 
dagang 

4.22. Mengentri transaksi-transaksi penjualan 
bagi perusahaan dagang 

4.23. Mengentri transaksi-transaksi pelunasan 
piutang bagi perusahaan dagang 

4.24. Mengentri transaksi-transaksi 
pengeluaran kas/bank bagi perusahaan 
dagang 

4.25. Mengentri transaksi-transaksi 
penerimaan kas/bank bagi perusahaan 
jasa dan dagang 

4.26. Membuat rekonsiliasi bank untuk 
perusahaan dagang 

4.27. Mengentri transaksi umum termasuk 
transaksi penyesuaian ke dalam jurnal 
umum perusahaan  dagang 

4.28. Membuat laporan keuangan untuk 
perusahaan dagang 

4.29. Membuat file backup untuk perusahaan 
dagang 
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Sebelum kamu memelajari buku ini, kamu diminta untuk menjawab 
semua pertanyaan di bawah ini dengan mencontreng kolom YA atau 
TIDAK. 

BUTIR PERTANYAAN YA TIDAK 

Apakah kamu dapat menyiapkan data awal? 
  

Apakah kamu dapat membuat daftar akun? 
  

Apakah kamu dapat menyesuaikan pajak? 
  

Apakah kamu dapat mengentri saldo awal? 
  

Apakah kamu dapat mencatat transaksi kas keluar? 
  

Apakah kamu dapat mencatat transaksi kas masuk? 
  

Apakah kamu dapat mencatat entri penyesuaian? 
  

Apakah kamu dapat menampilkan laporan keuangan? 
  

Apakah kamu dapat membuat file backup? 
  

 

F. Cek Kemampuan Awal 
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Proses pembelajaran yang dirancang untuk komputer akuntansi ini, 
lebih mengarah pada model pembelajaran berbasis masalah/kasus (Problem 
Based Learning), dimana para peserta didik dirangsang dan dilatih untuk mampu 
mencari solusi (pemecahan masalah) yang diberikan baik secara individual 
maupun kelompok. 

Tahapan-tahapan yang akan digunakan adalah sebagai berikut: 
 

FASE AKTIVITAS PESERTA DIDIK 

Fase 1. 

Identifikasi Kasus. 

 Identifikasi tujuan pembelajaran. 
 Identifikasi kelengkapan logistik. 
 Identifikasi kelengkapan informasi/ data 

dalam kasus yang diberikan. 

Fase 2. 

Organisasi Tugas. 

 Menentukan alternatif pemecahan kasus. 
 Inventarisasi tugas. 
 Pembagian tugas. 

Fase 3. 

Pelaksanaan tugas 
atau eksperimen 

 Mengumpulkan informasi yang sesuai 
untuk melaksanaan tugas. 

 Melaksanakan eksperimen 
 Mengatasi kesulitan/kesalahan yang 

terjadi dalam pelaksanaan eksperimen 

Fase 4. 

Penyajian hasil tugas. 

 Membuat laporan  
 Menyajikan hasil tugas 

Fase 5. 

Analisis dan Evaluasi 
proses pemecahan 
kasus. 

 Presentasi individu/kelompok  
 Mengevaluasi kasus yang diberikan 
 Mengevaluasi proses pemecahan kasus 

 
 
 
 
 
 

A. Deskripsi 

BAB II 

PEMBELAJARAN 
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Penulisan buku Komputer Akuntansi yang diaplikasikan pada 
perusahaan jasa ini dijabarkan dalam 8 (delapan) kegiatan belajar 
yaitu  meliputi : 

1. Kegiatan belajar 1 : Menyiapkan data awal perusahaan. 
2. Kegiatan balajar 2 : Membuat daftar akun 
3. Kegiatan belajar 3 : Menyesuaikan Pajak 
4. Kegiatan belajar 4 : Mengentri Saldo Awal 
5. Kegiatan belajar 5 : Mencatat Kas Keluar 
6. Kegiatan belajar 6 : Mencatat Kas Masuk 
7. Kegiatan belajar 7 : Mencatat Entri Penyesuaian 
8. Kegiatan belajar 8 : Menampilkan laporan Keuangan. 
9. Kegiatan belajar 9 : Membuat file backup 

Setiap kegiatan belajar dilengkapi dengan tujuan pembelajaran, 
uraian materi, rangkuman, tugas-tugas, tes formatif, kunci jawaban 
tes formatif, dan lembar kerja peserta didik.  

B. Kegiatan Belajar 



 

 

Direktorat Pembinaan SMK (2013) 
12 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 1

 

KEGIATAN BELAJAR 1 

MENYIAPKAN DATA AWAL 

 
 
 
 

 
 
 
 
 

 

 
 
 
 
 
 

 
 

 

 

a. Tujuan Pembelajaran 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada 
akhir sesi ini diharapkan peserta didik dapat:  

1. Menginstall program MYOB 

2. Menentukan menu untuk mengubah format tanggal dan 
simbol mata uang. 

3. Menyesuaikan format tanggal dan mata uang 

4. Membuat file data baru 

5. Mengecek Informasi Perusahaan 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Instalasi Program MYOB 

2. Menu Format Tanggal dan Simbol Mata Uang 

3. Penyesuaian Format Tanggal dan Simbol Mata Uang 

4. Pembuatan File Data Baru 

5. Pengecekan Informasi Perusahaan 
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1. Menginstall Program MYOB 

Ada lima unsur penting yang saling terkait dalam sistem komputerisasi di 
semua bidang, termasuk di bidang akuntansi, yaitu: 

a) Perangkat keras (hardwares), yaitu peralatan komputer dan peralatan 
elektronik lainnya yang digunakan untuk otomatisasi akuntansi. 

b) Perangkat lunak (softwares), yaitu program komputer dalam hal ini adalah 
aplikasi komputer akuntansi. Biasanya untuk menjalankan aplikasi ini 
diperlukan spesifikasi hardwares tertentu. 

c) Perangkat otak (brainwares), yaitu tenaga manusia yang memprogram dan 

mengoperasikan komputer. 

d) Data input dan output. Data input adalah data yang dientri dan diproses di 
komputer, sedangkan output adalah data yang dihasilkan atau disebut 
informasi. 

 
Perangkat lunak yang digunakan untuk komputerisasi akuntansi salah satunya 
adalah MYOB. Peralatan komputer yang dibutuhkan untuk pengoperasian 
program MYOB minimal mempunyai spesifikasi sebagai berikut: 

 200MHz Intel Pentium Processor with at least 64 MB RAM. 

 200 MB of Hardisk space. 

 16 bit colour, 1024x768 screen resolution. 

 Microsoft Windows versi 2000, XP, Vista atau yang terbaru 

 Windows compatible printer, mouse or pointing device. 

 
Untuk menginstall MYOB diperlukan program master, yaitu AccountingPlus 18 
versi edukasi yang dirilis oleh MYOB Australia yang tersimpan di dalam CD 
atau Flash Disk anda.  Program master tersebut memiliki 4 (empat) file seperti 
di gambar berikut ini:  

Gambar: 2. 1 Program Master MYOB AccountingPlus 18 
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Langkah-langkah untuk menginstall program MYOB sebagai berikut: 

Langkah Aktivitas-aktivitas 

1 Dobel Klik file Setup 

2 Pilih Complete instalation, proses instalasi berjalan secara 
otomatis 

3 Klik Yes setiap ada pertanyaan. 

4 Klik Finish, untuk mengakhiri proses instalasi 

 
 
2. Menu untuk Format Tanggal dan Simbol Mata Uang 

Menu yang digunakan untuk menyesuaikan format tanggal dan simbol 
mata uang Indonesia adalah langsung dari program Windows yaitu: 

Start  > Control Panel  >  Date, Time, Language and Regional Options 

 

3. Penyesuaian Format Tanggal dan Simbol Mata Uang. 

Format tanggal pada program MYOB sejak awal diformat (sistem 
Amerika) MM/DD/YYYY artinya Bulan/Tanggal/Tahun. Hal ini dapat 
menyebabkan kesalahan manakala digunakan oleh user di Indonesia 
karena terbiasa dengan format Tanggal/Bulan/Tahun. Oleh sebab itu 
sebelum mengaktifkan program MYOB peserta didik perlu mengubahkan 
menjadi format tanggal Indonesia dan simbol mata uang Dollar ($) 
diubah menjadi simbol mata uang Rupiah (Rp). 

Langkah-langkah untuk mengubah format tanggal dan simbol mata uang 
sebagai berikut: 

Langkah Aktivitas-aktivitas 

1 Klik  Start > Control Panel > Date, Time, Language and 
Regional Options 

2 Klik Regional and Language Options 

3 Pilih Indonesia dan Klik OK. 
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Gambar: 2. 2 Penyesuaian format tanggal dan simbol mata uang 

 

4. Pembuatan File Data Baru. 

File data baru adalah file data akuntansi yang digunakan untuk 
menyimpan seluruh data yang dientri ke dalam komputer. File ini dibuat 
(hanya sekali) yaitu pada saat perusahaan melakukan konversi dari 
sistem manual ke komputer akuntansi dengan menggunakan MYOB. 
File ini harus diberi nama oleh user dan secara otomatis program MYOB 
akan memberi ekstension MYO, contoh nama file: RID-Syn.myo. File ini 
akan digunakan selama perusahaan beroperasi. 

Langkah-langkah pembuatan file data baru (didasarkan pada kasus 
Renata Interior Design lihat di Lembar Kerja Peserta Didik).  

Langkah Aktivitas-aktivitas 

1 Aktifkan program MYOB dengan klik Starts>MYOB Accounting Plus 
v18ED atau dobel klik pada ikon MYOB dilayar komputer. 
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Langkah Aktivitas-aktivitas 

 
Gambar: 2. 3 Mengaktifkan program MYOB 

2 Klik Create pada tampilan Menu Awal 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar: 2. 4 Menu Utama 

3 Klik Next pada tampilan Welcome Windows 

4 Ketik identitas perusahaan. Kolom isian yang tidak boleh 

dikosongkan adalah nama perusahaan (company name). Jika telah 

selesai klik Next 
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Langkah Aktivitas-aktivitas 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 5 Identitas Perusahaan 

5 Ketik periode akuntansi, sesuaikan dengan kasus yang ada. 

kemudian klik Next 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 6 Periode Akuntansi 

6 Periksa kembali periode akuntansi. Bila ada data yang salah, klik 
Back dan betulkan data yang salah tersebut. Apabila data sudah 
benar, klik Next. 
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Langkah Aktivitas-aktivitas 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 7 Konfirmasi Periode Akuntansi 

Kesalahan input data periode akuntansi bisa berakibat fatal! 
Kesalahan ini tidak dapat diperbaiki ditengah atau di akhir proses. 
Pekerjaan yang telah anda lakukan menjadi sia-sia karena harus 
diulang dari awal. 

Langkah Aktivitas-aktivitas 

7 Pada penyusunan daftar akun, pilih cara kedua yaitu mengimport 
daftar akun dari sebuah file dan klik Next untuk meneruskan. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar: 2. 7 Pilihan penyusunan Daftar Akun 

 
 
 
 
 



 

  

Direktorat Pembinaan SMK (2013) 
19 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 1

 

Langkah Aktivitas-aktivitas 

8 Klik Change untuk mengubah nama file dan nama folder 

 
Gambar: 2. 8 Mengubah nama file dan folder 

9 Buat Folder Data MYOB18 dalam folder Documents dan kemudian 

klik folder tersebut. Ketik nama file: RID- Namamu masing-masing 

dan kemudian klik Save. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar: 2. 9 Ubah Nama file dan folder 
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Langkah Aktivitas-aktivitas 

10 Klik Next untuk memproses penyimpanan file, tunggu beberapa saat, 

kemudian klik Command Centre. Maka tampilan Command Centre 

akan dimunculkan seperti gambar berikut ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 10 Command Centre 

 

 

5. Pengecekan Informasi Perusahaan. 

File data baru yang akan digunakan sebagai tempat pencatatan data 
akuntansi telah disiapkan. Tapi apakah data yang telah di input ke dalam 
komputer itu benar? MYOB menyediakan fasilitas untuk mengecek 
kebenaran data, terutama untuk identitas perusahaan dan periode 
akuntansi. 
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Langkah-langkah untuk mengecek hasil pembuatan file data baru (kasus 
Renata Interior Design): 

Langkah Aktivitas-aktivitas 

1 Klik menu Setup dan pilih Company Information. 

 
Gambar: 2. 11 Menu Company Information 

2 Cek kebenaran informasi perusahaan, terutama identitas dan 
periode akuntansi. Jika identitas perusahaan ada yang salah dapat 
diedit. Tetapi jika ada data periode akuntansi yang salah maka 
proses pembuatan file data baru harus diulang kembali. Klik OK jika 
keduanya benar. 
 

 
 
Gambar: 2. 12 Company Information RID 
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c. Rangkuman 

 Format tanggal dan simbol mata uang disesuaikan dengan format 
Indonesia untuk menghindari kesalahan dalam input data. Hal ini bisa 
dilakukan melalui  program Windows dengan memanfaatkan fasilitas 
Control Panel. 

 Tidak boleh ada kesalahan mengisi periode akuntansi, terutama dalam 
menentukan bulan akhir periode dan  bulan konversi. Bulan akhir periode 
adalah bulan dimana akan disusun laporan keuangan selama satu 
periode. Bulan konversi (conversion month), adalah bulan dimana 

dilakukan pergantian sistem dari akuntansi manual ke sistem komputer 
akuntansi atau bulan dimana pencatatan saldo awal akan dilakukan. 

 Dalam MYOB ada tiga cara penyusunan daftar akun. Cara yang paling 
efektif, sesuai dan cepat adalah dengan mengimport daftar akun. Yang 
perlu diingat untuk cara ini adalah penyesuaian linked account untuk  
Bank, Sales, Purchase dan Payroll dan menghapus beberapa kaun yang 
tidak digunakan. 

 MYOB menyediakan 1 (satu) file data digunakan untuk menyimpan 
seluruh data akuntansi. File data ini diberi nama unik (tidak ada yang 
sama) dan diberi tambahan (ekstension) MYO. 
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Kerjakan tugas-tugas berikut ini ! 
 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Tugas 1, menginstall program MYOB versi 18 di komputer masing-
masing (jika memungkinkan). 

4. Tugas 2, cek format tanggal dan simbol mata uang di komputer 
masing-masing, bila formatnya masih default atau menggunakan 
format Amerika maka ubahlah ke format Indonesia.  

5. Tugas 3, buatlah file data bisnis baru didasarkan pada kasus Renata 
Interior Design  (lihat di Lembar Kerja Peserta Didik). Ikuti langkah-

langkah seperti yang tertulis di dalam buku ini. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. Tugas 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Unsur-unsur yang saling mempengaruhi dalam sistem komputerisasi 
akuntansi: 
a. Softwares, Hardwares, Program Applications, Inputs dan Outputs. 
b. Hardwares, Softwares, Input, dan Outputs 
c. Softwares, Hardwares, Brainwares, inputs dan Outputs. 
d. Input, Hardwares, Softwares, Process, dan Output. 
e. Hardwares, Program Aplication, inputs dan Outputs. 

2. Program MYOB termasuk kelompok: 
a. Input dan Output 
b. Hardwares 
c. Process 
d. Softwares 
e. Brainwares 

3. Format tanggal program MYOB Sejak awal adalah: 
a. YYYY/MM/DD 
b. DD/MM/YYYY 
c. MM/DD/YYYY 
d. YYYY/DD/MM 
e. MM/YYYY/DD 

4. Menu yang digunakan untuk pembuatan file data bisnis baru: 
a. Explore 
b. What’s New 
c. Open 
d. Create 
e. Exit. 

 
5. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong): 

a. Serial Number 
b. Company Name 
c. Address 
d. Phone and fax number 
e. Email Address. 

e. Tes Formatif 
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6. Yang dimaksudkan dengan Current Financial Year: 

a. Periode akuntansi yang sedang berjalan 
b. Periode akuntansi yang akan datang 
c. Periode akuntansi yang lalu 
d. Periode akuntansi selama perusahaan beraktivitas 
e. Periode akuntansi tertentu. 

7. Yang dimaksud dengan Last Month of Financial Year: 
a. Bulan awal dari periode akuntansi 
b. Bulan awal dan akhir dari periode akuntansi 
c. Bulan akhir dari periode akuntansi 
d. Akhir bulan (Desember) dari periode akuntansi 
e. Akhir bulan (Januari) dari periode akuntansi  

8. Yang dimaksud dengan Conversion Month: 
a. Bulan saat terjadinya transaksi keuangan 
b. Bulan pertama digunakan komputer akuntansi 
c. Bulan awal periode akuntansi yang berjalan 
d. Bulan akhir periode akuntansi yang berjalan 
e. Bulan pergantian periode akuntansi 

9. Jika perusahaan menggunakan jumlah periode 13 bulan, maka bulan 
ke-13 khusus untuk: 
a. Mencatat transaksi bulan Desember 
b. Mencatat transaksi awal periode 
c. Mencatat transaksi penyesuaian (adjustment) 
d. Mencatat transaksi kesalahan 
e. Mencatat rekonsiliasi akun-akun tertentu 

10. Nama file data bisnis harus unik, artinya: 
a. Nama file harus mudah diingat 
b. Nama file harus mudah ditemukan atau dicari 
c. Nama file harus spesifik tidak ada yang menyamai 
d. Nama file harus sama digunakan berkali-kali 
e. Nama file disimpan di folder khusus 
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2. Tes Keterampilan. 

Buatlah file data baru menggunakan program MYOB versi18 untuk perusahaan 
jasa Rio Interior Design (lihat Kasus 2 di Lembar Kerja Peserta Didik), dengan 
rincian sebagai berikut: 
 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan 
hasil pekerjaannya dalam bentuk file. 

3. Tugas 1, mencatat identitas perusahaan secara lengkap. 

4. Tugas 2, menetukan periode akuntansi. 

5. Tugas 3, menentukan cara penyusunan daftar akun (dengan cara 
mengimport). 

6. Tugas 4, menentukan nama folder (My Documents/Data MYOB 18 
dan nama file RIOD-nama peserta didik masing-masing. 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan  

 

1. Kunci Test Pengetahuan 
 

Soal No. Jawaban 

1 c 

2 d 

3 c 

4 d 

5 b 

6 a 

7 c 

8 b 

9 c 

10 c 
 

2. Kunci Tes Keterampilan 
 
Menu :  Setup > Company Information. 

 

Gambar: 2. 13 Company Information RIOD 

 

f. Kunci Jawaban Tes Formatif 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18. 
 

Kasus 1.1 : Pembuatan File Data Baru. 
 

Identitas perusahaan: 
Nama  :  Renata Interior Designer. 
Alamat  :  Pertokoan Pamulang Square Blok B1/17 
   :  Jl. Situ Bening, Pamulang, Tangerang Selatan 
Telpon/fax :  021 7434352 
email-addr :  go_rid@yahoo.com 

Periode akuntansi: 

Current Financial year :  2013 

Last month of the year : December,  

Conversion Month : January,  

Accounting Period : Twelve. 

Pembuatan daftar akun (Build your accounts list): 

Mengimport daftar akun dari file yang sudah disediakan. 

(I would like to import a list of accounts provided by  ….) 

Penyimpanan file: 

Folder  :  My Documents\Data MYOB18 

Nama File  :  RID-Nama Peserta Didik 

 

 
 
 
 
 
 
 
 
 
 
 

g. Lembar Kerja Peserta Didik 
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Kasus 1.2 : Pembuatan File Data Baru 
 

Identitas perusahaan: 
Nama  :  Rio Interior Design. 
Alamat  :  Pertokoan Pamulang Square Blok B1/17 
   :  Jl. Situ Bening, Pamulang, Tangerang Selatan 
Telpon/fax :  021 7434352 
email-addr :  go_riod@yahoo.com 

Periode akuntansi: 

Current Financial year :  2014 

Last month of the year : December,  

Conversion Month : January,  

Accounting Period : Twelve. 

Pembuatan daftar akun (Build your accounts list): 

Mengimport daftar akun dari file yang sudah disediakan. 

(I would like to import a list of accounts provided by  ….) 

Penyimpanan file: 

Folder  :  My Documents\Data MYOB18 

Nama File  :  RIOD-Nama Peserta Didik 

 

 

 

 

 

 

 

 

 

 

 
 
 

 
 
 
 



 

 

Direktorat Pembinaan SMK (2013) 
30 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 2

 

KEGIATAN BELAJAR 2 

MEMBUAT DAFTAR AKUN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Tujuan Pembelajaran 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir 
kegiatan belajar ini diharapkan peserta didik dapat:  

1. Mengidentifikasi tipe-tipe akun. 

2. Memilih menu untuk mengimport akun. 

3. Mengimport daftar akun. 

4. Menyesuaikan linked account. 

5. Menghapus dan mengedit akun-akun 

6. Mengecek Daftar Akun 

Lingkup materi kegiatan belajar ini meliputi:  

1. Tipe-tipe akun 

2. Menu mengimport daftar akun 

3. Langkah Import daftar akun 

4. Penyesuaian linked account 

5. Penghapusan dan edit akun-akun 

6. Pengecekan Daftar Akun 
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1. Tipe-tipe Akun 

Dalam MYOB, daftar akun dikelompokkan dalam 8 tipe, yaitu: 

Kode Tipe Akun Sub Tipe Akun Sub Tipe Akun 

1 Asset Assets dibagi 5: Liabilities dibagi 5: 

2 Liability  Bank 

 Accounts 
Receivable 

 Other Current 
Asset 

 Fixed Asset 

 Other Asset 

 

 Credit card 

 Accounts Payable 

 Other Current 
Liability 

 Long Term Liability 

 Other Liability 

 

3 Equity 

4 Income 

5 Cost of Sales 

6 Expense 

7 Tidak ada 

8 Other Income 

9 Other Expense   

Tabel: 2- 1 Tipe-tipe Akun 

Kode Akun 

Setiap akun memiliki kode 5 digit: 

Digit ke 1 : Kategori Akun. 

Digit ke 2 - 5 : Nomor ID Akun (Unik, tidak boleh ada yang sama). 

Kelompok Akun. 

a) Akun Header, berfungsi sebagai header, nilainya tidak dapat diposting 
(Non Postable). Akun ini biasanya tercetak dengan huruf tebal. 

b) Akun Detail, berfungsi sebagai child, nilainya dapat diposting 
(Postable). Akun ini tercetak dengan huruf biasa. 

2. Menu untuk Mengimport Daftar Akun 

Menu yang digunakan untuk mengimport daftar akun dari sebuah file sudah 
disiapkan: 
 

File > Import Data > Accounts  > Account Information 
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3. Langkah Import Daftar Akun 

Dalam praktik terdahulu, anda telah memilih mengimport daftar akun 
yang telah disediakan. Untuk hal tersebut anda harus mempunyai file 
yang berisi daftar akun untuk diimport ke dalam MYOB.  

Langkah-langkah mengimport daftar akun (Lihat Kasus 2.1. Renata 

Interior Designer di Lembar Kerja Peserta Didik) : 

Langkah   Aktivitas-aktivitas 

1 Klik File, pilih Import Data > Accounts  > Account Information 

2 Pada window Import File, lihat pada kolom Duplicate Records: pilih 
Update Existing Record, kemudian klik Continue. 

3 Pilih Folder Data MYOB18 dan file Daftar Akun RID, lalu klik Open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gambar: 2. 14 Mengimport Daftar Akun 

4 Pada window Import Data, klik Account Number dalam kolom Import 
Fields kemudian bawa ke kanan sejajar dengan Account Number 
dan klik pada kolom Matching Import Field. Lakukan cara yang 

sama untuk field-field lain. 

5 Klik Import dan tunggu beberapa saat untuk proses import 
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Langkah Aktivitas-aktivitas 

6 Klik OK pada window pemberitahuan hasil import 

Gambar: 2. 15 Memilih field-field yang diimport 
 

 

4. Penyesuaian Linked- Accounts 

MYOB menyediakan fasilitas untuk menghubungkan akun-akun tertentu (link), 

sehingga pada saat mencatat transaksi secara otomatis komputer menjurnal 
dan mengisi jumlah untuk akun buku besar atau akun pembantu yang terkait.  

a. Langkah-langkah menyesuaikan linked account untuk SALES  

(Lihat Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik) 

 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Linked Accounts, Sales Accounts. 

2 Sesuaikan linked account untuk Account Receivable dengan BCA 

Account seperti gambar 2.16 
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Gambar: 2. 16 Setup linked Sales Accounts  

3 Klik OK untuk mengakhiri 

 

b. Langkah-langkah menyesuaikan linked account untuk PURCHASES 

(Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik): 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Linked Accounts, Purchases Accounts. 

2 Sesuaikan linked account untuk Account Payable dengan BCA 

Account seperti gambar di bawah ini 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 17 Linked account untuk Purchases 

3 Klik OK untuk mengakhiri 
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c. Langkah-langkah menyesuaikan linked account untuk PAYROLLS: 

 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Linked Accounts, Payroll Accounts. 

2 Sesuaikan linked account untuk Cash Payment  dan Cheque 

Payment dengan BCA Account 

3 Klik OK untuk mengakhiri 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 18 Setup linked account untuk payroll 
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d. Cek kesesuaian linked account untuk ACCOUNTS & BANKING  

(Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik): 

 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Linked Accounts, Accounts and Banking Accounts 

2 Cek kesesuaian linked accounts seperti dalam gambar, Klik OK jika 

sudah sesuai. 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 19 Setup linked account untuk Accounts and Banking Accounts 
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5. Penghapusan dan Edit Akun-akun 

Program MYOB mempunyai fasilitas Easy Setup Assistant untuk menghapus 

akun-akun tertentu yang tidak digunakan oleh perusahaan. Hal ini 
dimaksudkan untuk menyederhanakan daftar akun sehingga mudah dicari.  

Langkah-langkah menghapus dan mengedit akun-akun  
(Lihat Kasus 2.3. Renata Interior Designer di Lembar Kerja Peserta Didik) 
 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Easy Setup assistant, Account dan Next 

 

 

 

 

 

 

 

 

Gambar: 2. 20 Easy Setup Assistant. 

2 Selanjutnya anda dapat dengan mudah untuk menghapus akun. 

Misalnya akan menghapus akun 1-0100 Cheque Account maka 

anda klik akun tersebut dan klik Delete . Hapus akun-akun sudah 

ditentukan. 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 21 Menghapus akun 
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Langkah Aktivitas-aktivitas 

3 Untuk meng-edit akun 3-0800 Retained Earning maka anda klik akun 

tersebut dan klik Edit . Selanjutnya anda mengedit no akun menjadi 

3-8000 dst. Edit akun-akun lainnya. 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 22 Meng-edit akun 

4 Jika sudah selesai menghapus dan mengedit akun, klik Close dua 
kali untuk keluar dari Easy Setup assistant. 
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6. Pengecekan Daftar Akun 

Untuk melihat atau memeriksa daftar akun yang tersusun dapat 
menggunakan menu dibawah ini: 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Account dan Account List 

 

Gambar: 2. 23 Meng-edit akun 

2 Klik Tab Asset, Liability, Equity dst. untuk memeriksa setiap 
kelompok daftar akun. Klik Close untuk mengakhiri. 

 

Gambar: 2. 24 Daftar akun kelompok Asset 
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Langkah Aktivitas-aktivitas 

 

 

Gambar: 2. 25 Daftar akun kelompok Liability 

 

 

Gambar: 2. 26 Daftar akun kelompok Equity 

 

 

Gambar: 2. 27 Daftar akun kelompok Income 
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Langkah Aktivitas-aktivitas 

 

 

Gambar: 2. 28 Daftar akun kelompok Cost of Sales 

 

 

 

Gambar: 2. 29 Daftar akun kelompok Expense 
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Langkah Aktivitas-aktivitas 

 

 

Gambar: 2. 30 Daftar akun kelompok Other Income 

 

 

Gambar: 2. 31 Daftar akun kelompok Other Expense 
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c. Rangkuman 

• Terdapat 8 kategori akun. Nomor 1 s.d. 6 meliputi: Asset, Liability, Equity, 
Income, Cost of Sales, Expense, 7 tidak ada, 8 other income dan 9 other 
expense. 

• Menu untuk mengimport daftar akun adalah:  

File > Import Data > Accounts  > Account Information. 

• Untuk import daftar akun diperlukan satu text file yang berisi daftar akun 
yang sudah diformat dengan delimeted tab. 

• MYOB akan memberi laporan tentang keberhasilan hasil import. 

• Linked account pada akun-akun tertentu hasil import  akan disesuaikan 
diantaranya adalah linked account untuk banking, sales, purhase dan 
payroll. 

• Untuk sebagian akun yang tidak digunakan akan dihapus atau akan 
diedit. 
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d. Tugas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kerjakan tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Tugas 1, mengimport Daftar Akun dari file Daftar Akun RID.txt  

4. Tugas 2, menyesuaikan linked account untuk Account & Banking, Sales, 
Purchases, dan Payroll. 

5. Tugas 3, edit akun-akun yang diperlukan dan hapus akun-akun yang 
tidak digunakan. Lihat Kasus 2.3 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Akun-akun pada program MYOB dibedakan dalam: 
a. 6 kategori 
b. 7 kategori 
c. 8 kategori 
d. 9 kategori 
e. 10 kategori 

2. Akun yang termasuk kategori 1 adalah: 
a. Account Payable 
b. Consultation Fee 
c. Bank charge 
d. Account Receivable 
e. Retained Earning  

3. Akun yang termasuk kategori 3 adalah: 
a. Account Payable 
b. Consultation Fee 
c. Bank charge 
d. Account Receivable 
e. Retained Earning  

4. Akun yang termasuk kategori 6 adalah: 
a. Account Payable 
b. Consultation Fee 
c. Bank charge 
d. Account Receivable 
e. Retained Earning  

 
5. Akun yang termasuk kategori 8 adalah: 

a. Interest Revenue 
b. Consultation Fee 
c. Bank charge 
d. Account Receivable 
e. Retained Earning  

 
 

e. Tes Formatif 
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6. Rumus untuk mengimport daftar akun: 
a. Account Information > File > Import Data > Accounts  
b. Import Data > File > Accounts  > Account Information 
c. File > Accounts > Import Data > Account Information 
d. File > Import Data > Accounts  > Account Information 
e. Accounts > File  > Import Data > Account Information 

 
7. Penyesuaian linked account untuk Account Payable dan BCA Account, 

adalah proses linked account untuk: 
a. Sales 
b. Payroll 
c. Purchase 
d. Account and Banking Account 
e. Liability  

 
8. Penyesuaian linked account untuk Wages & Salaries dan BCA 

Account, adalah proses linked account untuk: 

a. Sales 
b. Payroll 
c. Purchase 
d. Account and Banking Account 
e. Liability  

 
9. Penyesuaian linked account untuk Historical Balancing dan 

Undeposited Funds, adalah proses linked account untuk: 

a. Sales 
b. Payroll 
c. Purchase 
d. Account and Banking Account 
e. Liability  

 
10. Penyesuaian linked account untuk Account Receivable dan BCA 

Account, adalah proses linked account untuk: 

a. Sales 
b. Payroll 
c. Purchase 
d. Account and Banking Account 
e. Liability  
a. Bulan pergantian periode akuntansi 
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2. Tes Keterampilan. 

Buatlah daftar akun untuk perusahaan jasa Rio Interior Design  
(Lihat Kasus 2.4 di Lembar Kerja Peserta didik): 
 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan 
oleh peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan 
hasil pekerjaannya dalam bentuk file. 

3. Tugas 1, mengimport file : Daftar Akun RID.txt 

4. Tugas 2, menyesuaikan linked accounts. 

5. Tugas 3, menghapus dan mengedit akun-akun. Lihat Kasus 2. 4 
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f. Kunci Jawaban Tes Formatif 

 

 

 

 

Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan  

 

1. Kunci Test Pengetahuan 
 

Soal No. Jawaban 

1 c 

2 d 

3 e 

4 c 

5 a 

6 d 

7 c 

8 b 

9 d 

10 a 
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2. Kunci Tes Keterampilan 

Daftar Akun kelompok Asset: 

 

Gambar: 2. 32 Kelompok Asset 
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Daftar Akun kelompok Liability: 

 

Gambar: 2. 33 Kelompok Liability 

Daftar Akun kelompok Equity: 

 

Gambar: 2. 34 Kelompok Equity 
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Daftar Akun kelompok Income: 

 

Gambar: 2. 35 Kelompok Income 

Daftar Akun kelompok Cost of Sales: 

 

Gambar: 2. 36 Kelompok Cost of Sales 
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Daftar Akun kelompok Expense: 

 

Gambar: 2. 37 Kelompok Expense 
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Daftar Akun kelompok Other Income: 

 

Gambar: 2. 38 Kelompok Other Income 

Daftar Akun kelompok Other Expense: 

 

Gambar: 2. 39 Kelompok Other Expense 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 

komputer melalui program MYOB versi 18. 

Kasus 2.1  

Daftar akun perusahaan jasa Renata Interior Designer 

 Import Text file : Daftar Akun RID.txt  

 Penyesuaian linked account 

 Hapus dan edit akun-akun  

 
Renata Interior Design. 

Daftar Akun. 

Account No. Account Name Header Account Type 

10000 Assets H Asset 

11000 Current Assets H Asset 

11100 Cash On Hand H Asset 

11110 BCA Account  Bank 

11120 Payroll Cheque Account  Bank 

11130 Cash Drawer  Bank 

11140 Petty Cash  Bank 

11180 Undeposited Funds  Bank 

11190 Electronic Clearing Account  Bank 

11200 Account Receivables (Net) H Asset 

11210 Account Receivable  Accounts Receivable 

11220 Allowance for Doubtful Debts  Accounts Receivable 

11300 Other Current Assets H Asset 

11310 Office Supplies Inventory  Other Current Asset 

11320 Photography Supplies 
Inventory 

 Other Current Asset 

11330 Prepaid Insurance  Other Current Asset 

11340 Prepaid Rent  Other Current Asset 

12000 Fixed Assets H Asset 

12100 Professional Equipment H Asset 

12110 Prof Equipment at Cost  Fixed Asset 

12120 Prof Equipment Accum Dep  Fixed Asset 

12200 Furniture & Fixtures H Asset 

g. Lembar Kerja Peserta Didik 
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Account No. Account Name Header Account Type 

12210 Furniture & Fixtures at Cost  Fixed Asset 

12220 Furniture & Fixtures Accum 
Dep 

 Fixed Asset 

12300 Motor Vehicles H Asset 

12310 Motor Vehicles at Cost  Fixed Asset 

12320 Motor Vehicles Amortisation  Fixed Asset 

12400 Computer Equipment H Asset 

12410 Computer Equipment at Cost  Fixed Asset 

12420 Computer Equipment Accum 
Dep 

 Fixed Asset 

13000 Other Assets H Asset 

13100 Goodwill  Other Asset 

20000 Liabilities H Liability 

21000 Current Liabilities H Liability 

21100 Credit Cards H Liability 

21110 Bankcard  Credit Card 

21120 Visa  Credit Card 

21200 Account Payable  Accounts Payable 

21300 PPN Liabilities H Liability 

21310 PPN Collected  Other Current Liability 

21330 PPN Paid  Other Current Liability 

21400 Salary Payable   Other Current Liability 

21600 Customer Deposits  Other Current Liability 

21700 Other Current Liabilities  Other Current Liability 

22000 Long-Term Liabilities H Liability 

22100 BCA Loans  Long Term Liability 

22200 Other Long-Term Liabilities  Long Term Liability 

30000 Equity H Equity 

31000 Owner's Equity H Equity 

31100 Renata's Capital  Equity 

31200 Renata's Drawings  Equity 

38000 Retained Earnings  Equity 

39000 Current Year Earnings  Equity 

39999 Historical Balancing  Equity 

40000 Income H Income 

41000 Sales or Fees  Income 

42000 Consultation Fees  Income 

43000 Freight Collected  Income 
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Account No. Account Name Header Account Type 

44000 Late Fees Collected  Income 

45000 Miscellaneous Income  Income 

50000 Cost of Sales H Cost of Sales 

51000 Labour H Cost of Sales 

51100 Subcontractor Labour  Cost of Sales 

51200 Other Labour  Cost of Sales 

52000 Freight  Cost of Sales 

60000 Expenses H Expense 

61000 Accounting Fees  Expense 

61100 Advertising & Promotion  Expense 

61200 Bad Debt/Collection Expense  Expense 

61210 Bank Charges  Expense 

61300 Commissions  Expense 

61400 Depreciation Expense  Expense 

61500 Discounts H Expense 

61510 Discounts Given  Expense 

61520 Discounts Taken  Expense 

61600 Dues & Subscriptions  Expense 

61700 Equipment Rental  Expense 

61800 Insurance  Expense 

62000 Late Fees Paid  Expense 

62100 Laundry  Expense 

62200 Legal Fees  Expense 

62300 License & Permits  Expense 

62400 Maintenance & Cleaning  Expense 

62500 Office Supplies  Expense 

62600 Photography Supplies  Expense 

62700 Postage  Expense 

62800 Rent  Expense 

62900 Repairs  Expense 

62950 Shrinkage/Spoilage  Expense 

63010 Staff Amenities  Expense 

63030 Wages & Salaries  Expense 

63040 Workers' Compensation  Expense 

63100 Telephone  Expense 

63200 Travel & Entertainment  Expense 

63300 Uniforms  Expense 

63410 Electricity  Expense 
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Account No. Account Name Header Account Type 

63420 Gas  Expense 

63430 Water  Expense 

80000 Other Income H Other Income 

81000 Interest Income  Other Income 

90000 Other Expenses H Other Expense 

91000 Interest Expense  Other Expense 

 
Tabel: 2- 2 Daftar Akun 

 

Kasus 2.2  

Daftar akun (hasil import) dari perusahaan Renata Interior Designer 
Linked Accounts: SALES, PURCHASES, PAYROLLS 

 

Kasus 2.3 

Akun-akun yang perlu dihapus! 

Kode Nama Akun  Kode Nama Akun 

1-0100 Cheque Account  2-0300 Payroll Accrual Payable 

1-0150 Provision Account  3-0999 Historical Balancing 

1-0160 Investment Account  3-8000 Retained Earnings 

1-0180 Undeposited Funds  3-9000 Current Year Earning 

1-0190 Electronic Clearing 

Account 

 6-0100 Wages and Salaries 

1-0200 Trade Debtors  6-0200 Other Employer Expense 

2-0200 Trade Creditors    

Akun-akun yang harus diedit 

3-0800 Retained Earnings ► 3-8000 Retained Earnings 

3-0900 Current Year Earning ► 3-9000 Current Year Earning 

 
Tabel: 2- 3 Daftar Akun 
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Kasus 2.4 

Akun-akun yang perlu dihapus! 

Kode Nama Akun  Kode Nama Akun 

1-0100 Cheque Account  2-0300 Payroll Accrual Payable 

1-0150 Provision Account  3-0999 Historical Balancing 

1-0160 Investment Account  3-8000 Retained Earnings 

1-0180 Undeposited Funds  3-9000 Current Year Earning 

1-0190 Electronic Clearing 

Account 

 6-0100 Wages and Salaries 

1-0200 Trade Debtors  6-0200 Other Employer Expense 

2-0200 Trade Creditors    

Akun-akun yang harus diedit 

3-0800 Retained Earnings ► 3-8000 Retained Earnings 

3-0900 Current Year Earning ► 3-9000 Current Year Earning 

 
Tabel: 2- 4 Daftar Akun 
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a. Tujuan Pembelajaran 

KEGIATAN BELAJAR 3 

MENYESUAIKAN PAJAK 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir sesi ini 
diharapkan peserta didik dapat:  

1. Mengidentifikasi karakteristik perusahaan jasa 

2. Menjelaskan fungsi daftar akun 

3. Menjelaskan klasifikasi akun 

4. Menjelaskan sistem pengkodean akun 

5. Menyusun daftar akun perusahaan jasa 

Lingkup materi kegiatan belajar ini meliputi:  

1. Karakteristik perusahaan jasa 

2. Fungsi daftar akun 

3. Klasifikasi akun 

4. Sistem pengkodean akun 

5. Penyusunan daftar akun perusahaan jasa 
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1. Pajak Pertambahan Nilai 

Yang dimaksudkan dengan pajak di sini adalah Pajak Pertambahan Nilai 
(PPN). PPN adalah pajak yang dikenakan tidak hanya atas konsumsi barang 
kena pajak tetapi juga jasa kena pajak. Jadi perusahaan yang menjual 
layanan jasa kepada orang pribadi, perusahaan, maupun pemerintah harus 
dikenakan PPN sebesar tarif PPN, yaitu 10% dari nilai jual jasa yang 
dikonsumsi. 

Program MYOB telah menyediakan fasilitas yang menghitung besarnya pajak 
(PPN) secara otomatis setiap terjadi penjualan jasa, yaitu yang disingkat 
dengan GST (Goods and Services Tax). Oleh sebab itu diperlukan adanya 
penyesuaian terhadap pajak ini. 

Disamping itu masih ada satu jenis pajak lagi yang disediakan oleh  MYOB 
yang bisa dimanfaatkan, yaitu N-T (Not Reportable). Jenis pajak ini akan 

digunakan untuk menandai item-item atau transaksi-transaksi yang tidak 
terkena pajak. 

2. Menghapus Pajak yang Tidak Digunakan 

Daftar pajak yang ditampilkan oleh program MYOB v18 (versi Australia) 
adalah jenis-jenis pajak yang berlaku di Australia, oleh sebab itu jenis-
jenis pajak yang tidak digunakan di Indonesia perlu dihapus. 

Kasus 

Jenis-jenis pajak berikut ini tidak berlaku di Indonesia, oleh sebab itu 
perlu dihapus. 

Code Description Type Rate 

EXP GST Free Exports Good & Services Tax 0% 
FRE GST Free Good & Services Tax 0% 
GCA GST on Capital Aquisition Good & Services Tax 10% 
INP Input Taxed Purchases Input Taxed 10% 
ITS Input Taxed Sales Good & Services Tax 0% 
NTD Non Tax Deductible Input Taxed 0% 
PRI GST Private Use Good & Services Tax 10% 
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Langkah-langkah menghapus pajak yang tidak digunakan: 

Langkah Aktivitas-aktivitas 

1 Klik List, dan Tax Codes untuk menampilkan daftar pajak 

 

 

 

 

 

 

 

 

 

Gambar: 2. 40 Daftar pajak di Australia 

2 Hapus dengan memilih satu jenis pajak misalnya PRI (GST Private 
Use)  dan klik kanan-mouse, kemudian klik Delete.  

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 41 Menghapus jenis Pajak PRI. 

4 Ulangi cara yang sama untuk menghapus jenis pajak yang lainnya 

hingga tersisa dua jenis pajak: GST dan N-T. 
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3. Mengedit Jenis Pajak yang Digunakan 

Daftar pajak yang ditampilkan oleh program MYOB v18 (versi Australia) adalah 
jenis-jenis pajak yang berlaku di Australia, oleh sebab itu perlu disesuaikan 
dengan pajak-pajak yang berlaku di Indonesia.  

Kasus 

Jenis-jenis pajak berikut ini bisa digunakan di Indonesia, tetapi perlu 
diedit. 

Code Description Type Rate 

GST Good & Services Tax Good & Services Tax 10% 
N-T Non Reportable Good & Services Tax 0% 

 
 

Langkah-langkah mengedit pajak yang digunakan: 

Langkah Aktivitas-aktivitas 

1 Klik GST dan Edit  untuk mengedit jenis pajak GST diganti dengan 

PPN 

2 Pilih akun PPN Collected dan PPN paid untuk linked account 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 42 Mengedit GST menjadi PPN 

3 Klik OK untuk mengakhiri. 
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c. Rangkuman 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

o Jenis pajak GST (Goods and Services Tax) yang disediakan MYOB dapat 
diubah menjadi PPN (Pajak Pertambahan Nilai) karena kedua jenis pajak 
ini sama yaitu sebesar 10% dihitung dari total penjualan jasa. 

o Jenis pajak yang lainnya (pada MYOB) yaitu NT (Not Reportable) juga 
dapat dimanfaatkan untuk item-item atau transaksi yang tidak terkena 
pajak.  

o Jenis-jenis yang lainnya yang tidak digunakan di Indonesia dapat dihapus 
dari daftar pajak. 

o MYOB menyediakan menu untuk menyesuaikan (edit) atau menambah 
jenis pajak baru melalui: 

List  > Tax Codes. 
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d. Tugas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kerjakan tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Tugas 1, menghapus jenis-jenis pajak yang tidak digunakan (lihat 
Kasus 3.1 di lembar kerja peserta didik) 

4. Tugas 2, menyesuaikan GST menjadi PPN  

5. Tugas 3, Menyesuaikan linked account untuk PPN 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. GST adalah singkatan dari: 
a. Gross and Services Tax 
b. Good and Services Tax 
c. Goods and Services Tax 
d. Goods and Social Tax 
e. Goods and Sercives Type 

2. Jenis pajak GST yang disediakan oleh program MYOB sama dengan : 
a. PPh (Pajak Penghasilan) 
b. PPh (Pajak Penghasilan) 
c. PPN (Pajak Pertambahan Nilai) 
d. PPN (Pajak Pertambahan Nilai) 
e. PPn (Pajak penjualan)  

3. Tarif GST atau PPN adalah: 
a. 25% 
b. 5% 
c. 15% 
d. 10% 
e. 35% 

 
4. Jenis pajak N-T adalah singkatan dari: 

a. No Tax 
b. Not Tax 
c. Not Reportable 
d. No Reportable 
e. Not Taxable 

  
5. Jika total penjualan jasa sebesar Rp. 27.500.000,- (including Tax) maka 

besarnya PPN adalah: 
a. Rp. 2.750.000,- 
b. Rp. 1.375.000,- 
c. Rp. 2.500.000,- 
d. Rp. 5.000.000,- 
e. Rp. 1.250.000,- 

e. Tes Formatif 
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6. Jika total penjualan jasa sebesar Rp. 27.500.000,- (including Tax) maka 
besarnya pendapatan dari penjualan jasa adalah: 
a. Rp. 27.500.000,- 
b. Rp. 25.375.000,- 
c. Rp. 22.500.000,- 
d. Rp. 25.000.000,- 
e. Rp. 21.250.000,- 

7. Jika total penjualan jasa sebesar Rp. 27.500.000,- (excluding Tax) maka 
besarnya PPN adalah: 
a. Rp. 2.750.000,- 
b. Rp. 1.375.000,- 
c. Rp. 2.500.000,- 
d. Rp. 5.000.000,- 
e. Rp. 1.250.000,- 

8. Menu yang digunakan untuk mengedit atau menghapus jenis-jenis pajak 
adalah: 
a. Setup > List  > Tax Codes 
b. List  > Setup > Tax Codes 
c. Tax Codes  > List  
d. List  > Tax Codes 
e. Setup > Tax Codes  > List 

  
9. Akun GST Collected sinonim dengan: 

a. PPN Outcome and Income 
b. PPN Income 
c. PPN Paid 
d. GST In 
e. PPN Keluaran 

 
10. Akun GST Paid sinonim dengan: 

a. PPN Outcome and Income 
b. PPN Masukan 
c. GST Out 
d. PPN Outcome 
e. PPN Keluaran 
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2. Tes Keterampilan. 

Sesuaikan daftar pajak pada MYOB dengan Pajak yang berlaku di Indonesia 
(Lihat Kasus 3.1 di lembar kerja peserta didik):  

 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, menghapus pajak-pajak yang tidak berlaku 

4. Tugas 2, menyesuaikan pajak GST menjadi PPN. 

5. Tugas 3, menyesuaikan linked accounts. 
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f. Kunci Jawaban Tes Formatif 

 

 

 

Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 c 
2 d 
3 d 
4 c 
5 c 
6 d 
7 a 
8 d 
9 e 
10 b 
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2. Kunci Tes Keterampilan 

 

Gambar: 2. 43 Daftar Pajak yang disesuaian 

 

Gambar: 2. 44 Penyesuaian PPN 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 

Kasus 3.1. 
Jenis-jenis pajak berikut ini tidak berlaku di Indonesia, oleh sebab itu perlu 
dihapus. 
 

Code Description Type Rate 

EXP GST Free Exports Good & Services Tax 0% 
FRE GST Free Good & Services Tax 0% 
GCA GST on Capital Aquisition Good & Services Tax 10% 
INP Input Taxed Purchases Input Taxed 10% 
ITS Input Taxed Sales Good & Services Tax 0% 
NTD Non Tax Deductible Input Taxed 0% 
PRI GST Private Use Good & Services Tax 10% 

 

Jenis-jenis pajak berikut ini bisa digunakan di Indonesia, tetapi perlu diedit. 
 
Code Description Type Rate 

GST Good & Services Tax Good & Services Tax 10% 
N-T Non Reportable Good & Services Tax 0% 

 
Catatan: 
GST diubah menjadi PPN. 

 

g. Lembar Kerja Peserta Didik 
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KEGIATAN BELAJAR 4 

MENGENTRI SALDO AWAL 

 

 

 
 

 

 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

a. Tujuan Pembelajaran 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan 
belajar ini diharap-kan peserta didik dapat:  
 
1. Menjelaskan penentuan bulan konversi dan tanggal pencatatan bulan 

konversi  

2. Menyebutkan menu untuk pencatatan saldo awal 

3. Mencatat saldo awal 

Lingkup materi kegiatan belajar ini meliputi:  

1. Bulan konversi dan tanggal entri saldo awal 

2. Menu pencatatan saldo awal 

3. Pencatatan saldo awal 
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1. Penentuan Bulan Konversi dan Tanggal Entri Saldo Awal. 

Pengisian bulan konversi yang dilakukan pada saat pembuatan file data baru 
berpengaruh pada pengentrian saldo awal. Bila bulan konversi ditentukan 
Januari maka secara otomatis MYOB mencatat tanggal pengentrian saldo awal 
adalah 1 Januari. Bila bulan konversi diisi Desember maka ini berarti bahwa 
saldo awal akan dientri pada tanggal 1 Desember. 

Jika bulan konversi ditentukan pada bulan Juli atau Januari maka MYOB hanya 
mencatat saldo akun-akun riil (akun neraca) dan tidak menerima akun-akun 
nominal (akun laba-rugi). MYOB akan menerima saldo kelompok akun riil dan 
nominal, hanya apabila bulan konversi ditentukan bukan bulan Januari atau 
Juli. 

Apabila ada kasus dimana saldo awal meliputi saldo dari akun-akun riil dan 
nominal sedang bulan konversi ditentukan bulan Juli atau Januari, maka cara 
pecatatannya adalah sebagai berikut: 

a. Saldo akun-akun riil dientri melalui menu pencatatan saldo awal (Accounts 
Opening Balances) yang disediakan oleh MYOB. Tentunya ini akan terjadi 
ketidak-seimbangan dimana ditunjukkan pada saldo Akun Historical 
Balancing sejumlah angka tertentu (bukan 0). 

b. Saldo akun-akun nominal dientri melalui jurnal umum (Record Journal 
Entry). Tentunya jumlah debet dan kreditnya akan terlihat tidak seimbang. 
Sebagai penyeimbangnya adalah akun Historical Balancing, yaitu sejumlah 
selisihnya. 

2. Menu untuk Entri Saldo Awal 

Menu yang digunakan untuk entri saldo awal adalah sebagai berikut: 

Setup  > Balances  > Accounts Opening Balances 

 

Gambar: 2. 45 Menu Entri Saldo Awal 
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3. Pencatatan Saldo Awal 

Program MYOB memberi fasilitas Accounts Opening Balances untuk mengentri 
saldo awal akun buku besar dan sekaligus mengecek kesamaan total debet 
dan kreditnya. 

Langkah-langkah mengentri saldo Neraca Awal: 

Langkah Aktivitas-aktivitas 

1 Klik Setup, Balances, Accounts Opening Balances 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gambar: 2. 46 Setup Account Opening Balances 

2 Ketik saldo untuk akun-akun. Caranya ketik saldo sesuai dengan 
nama akun, misalnya akun BCA Account jumlah saldonya 
45.000.000,- diketik 45000000 dan press Enter.  
Untuk Cash Drawer ketik 10000000 dan press Enter. Untuk Petty 
Cash ketik 5000000 dan press Enter. Dst 

 
Gambar: 2. 47 Account Opening Balances 
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Langkah Aktivitas-aktivitas 

4 Khusus untuk saldo akun-akun kotra diketik didahului dengan – 
(minus) diikuti jumlah uangnya, contoh saldo akun Prof Equipment 
Accum. Depre. diketik: –7000000 (minus 7000000) atau saldo akun 
Renata’s Drawings diketik -17500000 (minus 17500000). 

 
Gambar: 2. 48 Account Opening Balances 

5 Jika semua saldo akun sudah dientri, maka catatan yang ada 
dibawah : Amount left to be allocated sebanyak 0 (nol). Jika tidak 
maka terjadi ketidak seimbangan saldo neraca 
 

 
Gambar: 2. 49 Neraca yang seimbang 

6 Klik OK untuk mengakhiri 

 

total Dr = 
total Cr 
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c. Rangkuman 

 Pada MYOB, pemilihan bulan konversi ditentukan oleh tanggal saldo awal. 
Jika tanggal saldo awal 1 Januari 2013 maka bulan konversi hendaknya 
dipilih Januari. 

 Apabila bulan konversi ditentukan Januari atau Juli maka hanya saldo 
akun-akun riil yang bisa dientri ke dalam “Account Opening Balances”. 

 Jika dalam daftar saldo awal terdapat kelopok akun riil dan akun nominal 
dan bulan konversi ditentukan bulan Januari atau Juli maka entri saldo 
awal dilakukan melaui dua cara, pertama melalui “Account Opening 
Balances” dan yang kedua melalui Record Journal Entry. 

 Yang perlu diperhatikan dalam entri saldo awal adalah adanya akun-akun 
kontra. Saldo akun kontra dientri dengan memberikan tanda – (minus) di 
awal angka saldonya. 

 Menu yang digunakan untuk entri saldo awal adalah: 

Setup > Balances > Accounts Opening Balances. 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 
 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk menyelesaikan tugas berikut ini. 

4. Tugas 1, mengentri saldo awal akun-akun asset 

5. Tugas 2, mengentri saldo awal akun-akun liability 

6. Tugas 3, mengentri saldo awal akun-akun equity 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Dalam pembuatan file data baru ditentukan, Tahun periode: 2013, bulan 
konversi ditentukan bulan Desember, maka MYOB akan mencatat saldo 
awal pada tanggal: 
a. 1 Januari 2013 
b. 1 Nopember 2013 
c. 1 Desember 2013 
d. 31 Desember 2013 
e. 1 Januari 2014 

2. Dalam kasus ditunjukkan bahwa data saldo awal tercatat pada tanggal 30 
Nopember 2013, maka sebaiknya bulan konversi yang dipilih adalah: 
a. Oktober 
b. Nopember 
c. Desember 
d. Januari 
e. Pebruari 

3. Jika bulan konversi ditentukan Desember, maka saldo-saldo akun yang 
dapat dientri adalah: 
a. Hanya saldo Nominal 
b. Hanya saldo Rill 
c. Saldo Nominal dan Saldo Riil 
d. Tidak ada saldo yang dapat dientri 
e. Saldo Neraca 

4. Jika bulan konversi ditentukan Januari, maka saldo-saldo akun yang dapat 
dientri adalah: 
a. Hanya saldo Nominal 
b. Hanya saldo Rill 
c. Saldo Nominal dan Saldo Riil 
d. Tidak ada saldo yang dapat dientri 
e. Saldo Laba-Rugi 

 
 
 

e. Tes Formatif 



 

 

Direktorat Pembinaan SMK (2013) 
78 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 4

 

5. Jika bulan konversi ditentukan Juli, maka saldo-saldo akun yang dapat 
dientri adalah: 
a. Hanya saldo Nominal 
b. Hanya saldo Rill 
c. Saldo Nominal dan Saldo Riil 
d. Tidak ada saldo yang dapat dientri 
e. Saldo Laba-Rugi 

6. Yang dimaksudkan dengan akun kontra 
a. Akun-akun debet 
b. Akun-akun kredit 
c. Akun-akun Riil 
d. Akun-akun Nominal 
e. Akun lawan, sebagai pengurang. 

 
7. Yang termasuk akun kontra di bawah ini adalah: 

a. Account Receivable 
b. Account Payable 
c. Provision on Doubtful Debt 
d. Investment 
e. Bank Loan 

 
8. Cara pencatatan saldo akun kontra adalah 

a. Dicatat di sebelah debet 
b. Dicatat di sebelah kredit 
c. Dicatat dengan angka plus 
d. Dicatat dengan angka minus 
e. Dicatat terbalik 

 
9. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing 

terdapat saldo Rp. 550.000,- ini memberi tanda: 
a. Terdapat kesalahan input sebesar Rp. 550.000,- 
b. Jumlah debet lebih kecil sebesar Rp. 550.000,- 
c. Jumlah debet lebih besar sebesar Rp. 550.000,- 
d. Terdapat kelebihan kredit sebesar Rp. 550.000,- 
e. Tidak bermasalah, karena itu adalah saldo akun tersebut. 

10. Menu untuk entri saldo awal adalah: 
a. Setup > Balances > Accounts Opening Balances 
b. Setup > Accounts > Opening Balances Balances   
c. Balances > Setup > Accounts Opening Balances 
d. Accounts Opening Balances > Setup > Balances 
e. Account > Balances > Accounts Opening Balances 
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2. Tes Keterampilan. 

Didasarkan pada kasus: Rio Interior Design, kerjakan tes ini dengan ketentuan 
sebagai berikut: 

 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, mengentri saldo awal akun-akun asset 

4. Tugas 2, mengentri saldo awal akun-akun liability 

5. Tugas 3, mengentri saldo awal akun-akun equity  
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 c 
2 c 
3 c 
4 b 
5 b 
6 e 
7 c 
8 d 
9 c 
10 a 

 
 

f. Kunci Jawaban Tes Formatif 
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2. Kunci Tes Keterampilan 

 
 
Gambar: 2. 50 Neraca Saldo Rio Interior Design 
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g. Lembar Kerja Peserta Didik 

 
 

 

 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 

komputer melalui program MYOB versi 18. 

Kasus 1. 

Perusahaan jasa: Renata Interior Designer 

Neraca Saldo per 1 Januari 2013 

 

Nama Akun Debet (Rp.) Kredit (Rp.) 

BCA Account 45.000.000    

Cash Drawer 10.000.000  

Petty Cash 5.000.000    

Office Supplies Inventory 5.250.000    

Photography Supplies Inventory 10.000.000    

Prof Equipment at Cost 35.000.000    

Prof Equipment Accum Dep   7.000.000  

Furniture and Fixtures at Cost 32.000.000    

Furniture and Fixtures Accum Dep   6.400.000  

Computer Equipment at Cost 37.000.000    

Computer Equipment Accum Dep   14.800.000  

Bankcard   6.000.000  

Wage/Salary Payable  5.050.000 

PPN Payable   7.500.000  

BCA Loans   50.000.000  

Renata’s Drawings 17.500.000    

Renata’s Capital   100.000.000  

Total 196.750.000  196.750.000  

 

Tabel: 2- 5 Neraca Saldo Renata Interior Designer 
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Kunci Jawaban Kasus 1  Renata Interior Designer 
 

 
 
Gambar: 2. 51 Neraca Saldo Kasus 1 Renata Interior Designer 
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Kasus 2. 

Perusahaan jasa: Rio Interior Design 

Neraca Saldo per 1 Januari 2014 

 
Nama Akun Debet (Rp.) Kredit (Rp.) 

BCA Account 45.000.000    

Cash Drawer 10.000.000  

Petty Cash 5.000.000    

Office Supplies Inventory 5.250.000    

Photography Supplies Inventory 10.000.000    

Prof Equipment at Cost 35.000.000    

Prof Equipment Accum Dep   7.000.000  

Furniture and Fixtures at Cost 32.000.000    

Furniture and Fixtures Accum Dep   6.400.000  

Computer Equipment at Cost 37.000.000    

Computer Equipment Accum Dep   14.800.000  

Bankcard   6.000.000  

Wage/Salary Payable  5.050.000 

PPN Payable   7.500.000  

BCA Loans   50.000.000  

Renata’s Drawings 17.500.000    

Renata’s Capital   100.000.000  

Total 196.750.000  196.750.000  

 
Tabel: 2- 6 Neraca Saldo Rio Interior Design 
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a. Tujuan Pembelajaran 

KEGIATAN BELAJAR 5 

MENCATAT TRANSAKSI 

PEMBAYARAN 

 
 
 

 
 
 
 

 
 
 
 
 
 
 

 
 
 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan 
belajar ini diharap-kan peserta didik dapat:  

 
1. Mendefinisikan transaksi pembayaran 

2. Menunjukan menu untuk mencatat transaksi pembayaran 

3. Mencatat pembayaran dengan cek 

4. Mencatat pembayaran dengan kas kecil 

5. Mencatat pembayaran dengan bankcard 

6. Memeriksa jurnal transaksi pembayaran 

Lingkup materi kegiatan belajar ini meliputi:  
 

1. Pengertian transaksi pembayaran 

2. Menu untuk mencatat transaksi pembayaran 

3. Pencatatan pembayaran dengan cek 

4. Pencatatan pembayaran dengan kas kecil 

5. Pencatatan pembayaran dengan bankcard 

6. Pemeriksaan Jurnal transaksi pembayaran 
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1. Pengertian Transaksi Pembayaran 

 
Perusahaan jasa dalam operasinya, selalu melakukan transaksi pembayaran. 
Yang dimaksud dengan transaksi pembayaran dalam hal ini adalah kegiatan 
pengeluaran uang untuk keperluan operasi perusahaan, misalnya untuk 
pembelian supplies, pembayaran beban sewa, beban listrik, telepon, beban 
iklan, beban gaji dsb. 

Pada umumnya perusahaan menggunakan 3 (tiga) cara pembayaran yaitu: 

a. Pembayaran dengan Cek (cash in Bank) 
b. Pembayaran dengan Dana Kas Kecil (Petty cash) 
c. Pembayaran dengan Kartu Kredit (Bankcard) 

Dalam kegiatan belajar 5 ini akan dijelaskan bagaimana pencatatan 
pembayaran dengan ketiga cara tersebut di atas bila dikerjakan dalam program 
MYOB. 

2. Menu untuk Mencatat Transaksi Pembayaran 
 

MYOB menyediakan menu Command Centre Banking – Spend Money 
untuk mencatat transaksi pengeluaran kas, baik melalui cek, dana kas 
kecil atau bankcard. 

Banking  > Spend Money 

 

Gambar: 2. 52 Menu untuk mencatat transaksi pembayaran 
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3. Pencatatan Pembayaran Dengan Cek 
 
Untuk mencatat pembayaran dengan cek dalam MYOB menggunakan menu 
yang sama Command Centre Banking – Spend Money,  untuk kolom Pay from 
Account diisi dengan akun penyimpanan kas di bank, dalam kasus Renata 

Interior Designer ini adalah BCA Account. 

Langkah-langkah pembayaran dengan Cek (Kasus: Renata Interior Designer): 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Spend Money. 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 53 Menu Banking – Spend Money 

2 Ketik data pengeluaran kas sebagai berikut. 

 
Gambar: 2. 54 Pembayaran dengan Cek 
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Langkah Aktivitas-aktivitas 

3 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum 
dicatat (record). 

 
Gambar: 2. 55 Recap jurnal pembayaran dengan cek 

4 Jika sudah benar klik OK kembali ke window spend money 

5 Klik Record  untuk memproses jurnal 

6 Klik Cancel untuk kembali ke Menu Utama 
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4. Pencatatan Pembayaran dengan Dana Kas Kecil 

Untuk mencatat pembayaran dengan Dana Kas Kecil dalam MYOB 
menggunakan menu yang sama Command Centre Banking – Spend Money,  
untuk kolom Pay from Account diisi dengan akun Petty Cash. 

Langkah-langkah mencatat pembayaran dengan kas kecil (Kasus: Renata 
Interior Designer) 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Spend Money. 

2 Mengganti BCA Account menjadi Petty Cash 

 
Gambar: 2. 56 Seting Petty Cash 

3 Ketik data pengeluaran kas seperti tampak pada gambar berikut 

 
Gambar: 2. 57 Pembayaran dengan petty cash 
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Langkah Aktivitas-aktivitas 

4 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum di 
record. 

 
Gambar: 2. 58 Recap jurnal pembayaran dengan petty cash. 

5 Jika sudah benar klik OK kembali ke window spend money 

6 Klik Record  untuk memproses jurnal 

7 Klik Cancel untuk kembali ke Menu Utama 
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5. Pencatatan Pembayaran dengan BankCard 

Untuk mencatat pembayaran dengan bankcard dalam MYOB menggunakan 
menu yang sama Command Centre Banking – Spend Money,  untuk kolom Pay 
from Account diisi dengan akun BankCard. 

Langkah-langkah pembayaran dengan bankcard (Kasus Renata Interior 
Designer): 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Spend Money 

2 Mengganti BCA Account menjadi Bankcard 

 
Gambar: 2. 59 Seting Bank card. 

3 Ketik data pengeluaran kas seperti tampak pada gambar berikut 

 
Gambar: 2. 60 Pembayaran dengan BankCard 
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6. Pemeriksaan Jurnal Transaksi Pembayaran 

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu 
Command Centre Banking – Transaction Journal. Kemudian tanggalnya di set 
dari 1/1/2013 – 31/1/2013. 

Langkah-langkah melihat jurnal pembayaran (Kasus: Renata Interior Designer): 
 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Transaction Journal 
 

 
Gambar: 2. 61 Menu melihat jurnal pembayaran 

2 Klik Tab Disbursements dan tanggal diset dari 1/1/2013 s.d. 
31/1/2013 

 
Gambar: 2. 62 Melihat jurnal Pembayaran 
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c. Rangkuman 

o Yang dimaksud dengan transaksi pembayaran adalah transaksi 
pengeluaran kas oleh perusahaan jasa untuk keperluan operasi, misalnya 
pembelian supplies, pembayaran beban-beban operasi dan sebagainya. 

o Minimal ada 3 (tiga) cara pembayaran yang dilakukan perusahaan yaitu 
pembayaran dengan cek, dengan dana kas kecil atau dengan bankcard. 

o Program MYOB menyediakan menu yang sama untuk ketiga cara 
pembayaran tersebut yaitu: 

Banking > Spend Money. 

o Pembayaran dengan cek, kolom Pay from Account diisi dengan Cash in 
Bank (BCA Account). 

o Pembayaran dengan dana kas kecil, kolom Pay from Account diisi dengan 
Petty Cash. 

o Pembayaran dengan bankcard, kolom Pay from Account diisi dengan 
Bankcard. 

o Program MYOB menyediakan menu untuk melihat jurnal transaksi 
pembayaran yaitu: 

Banking > Transaction Journal > Tab Disbursement > Set Date 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 
 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang 
per kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk menyelesaikan tugas berikut ini. 

4. Tugas 1, mencatat pembayaran dengan cek. 

5. Tugas 2, mencatat pembayaran dengan dana kas kecil. 

6. Tugas 3, mencatat pembayaran dengan bankcard. 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Yang dimaksud dengan transaksi pembayaran bagi perusahaan jasa adalah: 
a. Pembelian barang dagangan secara tunai 
b. Pembayaran utang dari pembelian barang dagang secara kredit. 
c. Pengeluaran kas untuk pembelian supplies secara tunai 
d. Pengeluaran kas untuk pembelian bahan baku secara tunai 
e. Pengeluaran kas untuk keperluan pribadi pemilik perusahaan. 

2. Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB 
adalah : 
a. Banking > Pay Bill  
b. Banking > Spend Money 
c. Banking > Money Out  
d. Banking > Banking Register > Spend Money 
e. Banking Register > Spend Money 

 
3. Menu untuk mengentri transaksi pembayaran dengan Cek: 

a. Banking > Pay Bill > Pay from Account: BCA Account 
b. Banking > Spend Money > Pay from Account: BCA Account 
c. Banking > Money Out > Pay from Account: BCA Account 
d. Banking > Banking Register > Pay from Account: BCA Account 
e. Banking Register > Pay Bill > Pay from Account: BCA Account 

 
4. Menu untuk mengentri transaksi pembayaran dengan Dana Kas Kecil: 

a. Banking > Pay Bill > Pay from Account: Petty Cash 
b. Banking > Money Out > Pay from Account: Petty Cash 
c. Banking > Banking Register > Pay from Account: Petty Cash 
d. Banking > Spend Money > Pay from Account: Petty Cash  
e. Banking Register > Pay Bill > Pay from Account: Petty Cash 

 
5. Menu untuk mengentri transaksi pembayaran dengan Bankcard: 

a. Banking > Pay Bill > Pay from Account: Bankcard 
b. Banking > Money Out > Pay from Account: Bankcard 
c. Banking > Banking Register > Pay from Account: Bankcard 
d. Banking Register > Pay Bill > Pay from Account: Bankcard 
e. Banking > Spend Money > Pay from Account: Bankcard 

e. Tes Formatif 
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6. Jika ada transaksi pembayaran beban iklan dengan kas kecil sebesar       
Rp. 300.000,- maka MYOB akan memproses jurnalnya: 
a. Dr: Advertising Rp. 300.000,- Cr: Petty Cash Rp. 300.000,- 
b. Dr: Petty Cah Rp. 300.000,- Cr: Advertising Rp. 300.000,- 
c. Dr: BCA Account Rp. 300.000,- Cr: Petty Cash Rp. 300.000,- 
d. Dr: Advertising Rp. 300.000,- Cr: BCA Account Rp. 300.000,- 
e. Dr: Advertising Rp. 300.000,- Cr: Bankcard Rp. 300.000,- 

 
7. Jika ada transaksi pembelian Supplies dengan cek sebesar Rp. 3.000.000,- 

maka MYOB akan memproses jurnalnya: 
a. Dr: Supplies Rp. 3.000.000,- Cr: Petty Cash Rp. 3.000.000,- 
b. Dr: Petty Cah Rp. 3.000.000,- Cr: Supplies Rp. 3.000.000,- 
c. Dr: BCA Account Rp. 3.000.000,- Cr: Supplies Rp. 3.000.000,- 
d. Dr: Supplies Rp. 3.000.000,- Cr: BCA Account Rp. 3.000.000,- 
e. Dr: Supplies Rp. 3.000.000,- Cr: Bankcard Rp. 300.000,- 

 
8. Jika ada transaksi pembelian pulsa HP dengan bankcard sebesar Rp. 

200.000,- maka MYOB akan memproses jurnalnya: 
a. Dr: Telephone Rp. 200.000,- Cr: Petty Cash Rp. 200.000,- 
b. Dr: Petty Cah Rp. 200.000,- Cr: Telephone Rp. 200.000,- 
c. Dr: BCA Account Rp. 200.000,- Cr: Telephone Rp. 200.000,- 
d. Dr: Telephone Rp. 200.000,- Cr: BCA Account Rp. 200.000,- 
e. Dr: Telephone Rp. 200.000,- Cr: Bankcard Rp. 200.000,- 

 
9. Sebelum me-record transaksi pembayaran, selalu dianjurkan untuk menekan 

Ctrl-R. Tujuan langkah ini adalah untuk:  
a. Menghindari kesalahan dalam pencatatan. 
b. Membetulkan jika ada kesalahan dalam pencatatan. 
c. Mengeliminir kesalahan dalam jurnal  
d. Mengecek kebenaran jurnal sebelum diproses 
e. Mengecek kebenaran jurnal sesudah diproses 

 
10. Dalam MYOB klik Record terhadap pencatatan transaksi berarti: 

a. Memerintahkan komputer untuk memperoses jurnalnya. 
b. Memerintahkan komputer untuk menghapus jurnalnya. 
c. Memerintahkan komputer untuk membatalkan jurnalnya. 
d. Memerintahkan komputer untuk memproses ulang jurnalnya. 
e. Memerintahkan komputer untuk memproses jurnal dan posting ke buku 

besar serta buku pembantu. 
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2. Tes Keterampilan. 

Didasarkan pada kasus 2: Rio Interior Design, kerjakan tes ini dengan 
ketentuan sebagai berikut: 
 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 

peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil 

pekerjaannya dalam bentuk file. 

3. Tugas 1, mengentri transaksi pembayaran dengan cek. 

4. Tugas 2, mengentri transaksi pembayaran dengan kas kecil 

5. Tugas 3, mengentri transaksi pembayaran dengan bankcard 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

Soal No. Jawaban 

1 c 
2 b 
3 b 
4 d 
5 e 
6 e 
7 c 
8 d 
9 c 
10 a 

 
 

f. Kunci Jawaban Tes Formatif 
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2. Kunci Tes Keterampilan 

 

Gambar: 2. 63 Jurnal pembayaran kasus 5.2 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18. 
 
Kasus 5.1.  Perusahaan Jasa Renata Interior Designer 

Transaksi penarikan Cek BCA no. Chq. 230 untuk pembayaran: 

Date Transaction Amount (Rp). Tax 

10/1/13 Pembayaran gaji karyawan Des 2012 
Pembayaran premi asuransi 
Pembayaran PPN Payable 
Pembelian Komputer 
Pembayaran Bankcard bill terutang 
Pembayaran beban iklan 
Pembayaran beban sewa 

5.500.000,- 
1.100.000,- 
7.500.000,- 
7.300.000,- 
6.000.000,- 
2.430.000,- 
2.500.000,- 

N-T 

 Total 32.330.000,-  

 
Tabel: 2- 7 Transaksi pengeluaran kas dengan cek kasus 5.1 

Date Transaction Tax Details 

 
15/1/13 

 
Pembayaran beban: 
Laundry     Rp. 100.000,- 
Postage           Rp.   76.000,-  
Staff amenitis   Rp. 220.000,- 
 

 
N-T 
N-T 
N-T 

 
PC Voucher V-017 
Memo: Petty cash 
items 

 
Tabel: 2- 8 Transaksi Pengeluaran Kas Kecil kasus 5.1 

Transaksi pengeluaran kas dibayar dengan Bankcard: 

Date Transaction Tax Details 

 
18/1/13 

 
Pembayaran: 
Tagihan Telkom  Rp. 585.000,- 
Tagihan Listrik     Rp. 421.000,- 
 

 
N-T 

 
No B-029 
Memo: Computer 
purchase 

 

Tabel: 2- 9 Transaksi Pembayaran dengan Bankcard kasus 5.1 

 

g. Lembar Kerja Peserta Didik 



 

  

Direktorat Pembinaan SMK (2013) 
101 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 5

 

Kasus 5.2 Perusahaan Jasa Rio Interior Design 

Transaksi pembayaran dengan Cek BCA  
 

Date Transaction Tax Details 

2/1/14 Pembayaran gaji karyawan 
Des’13 sebesar  
Rp. 5.500.000,- 

N-T Chq No 320 
Memo: Paid salaries payable 

2/1/14 Pembayaran premi asuransi 
sebesar  
Rp. 1.100.000,- 

N-T Chq No 321 
Memo: Paid insurance 

3/1/14 Pembayaran PPN Payable 
sebesar Rp.7.500.000,- 

N-T Chq No 322 
Memo: Paid PPN Payable 

4/1/14 Pembelian peralatan komputer 
Rp. 7.300.000,- 

N-T Chq No 323 
Memo: Paid for Computer 

5/1/14 Pembayaran Bankcard bill 
terutang sebesar.  
Rp. 6.000.000,- 

N-T Chq No 324 
Memo: Paid Bankcard bill 

6/1/14 Pembayaran beban iklan 
sebesar Rp. 2,430.000,- 

N-T Chq No 325 
Memo: Paid Advertising 

7/1/14 Pembayaran beban sewa 
sebesar Rp.2.500.000,- 

N-T Chq No 326 
Memo: Paid Monthly rent 

 
Tabel: 2- 10 Transaksi Pengeluaran dengan Kas Kecil Kasus 5.2 

Transaksi pengeluaran kas dibayar dengan Petty Cash:  

 

Date Transaction Tax Details 
8/1/14 Pembayaran beban: 

Laundry     Rp. 100.000,- 
Postage            Rp. 76.000,- 

 
N-T 
N-T 

No. V-01 
Memo: Petty cash items 

9/1/14 Pembayaran untuk staff 
amenities (teh, gula, kopi)    
Rp. 220.000,- 

N-T No. V-02 
Memo: Petty cash items 

 
Tabel: 2- 11 Transaksi Pengeluaran dengan Bankcard Kasus 5.2 
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a. Tujuan Pembelajaran 

KEGIATAN BELAJAR 6 

MENCATAT TRANSAKSI 

PENERIMAAN 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir 
kegiatan belajar ini diharap-kan peserta didik dapat:  

1. Mendefinisikan transaksi penerimaan 

2. Menunujukkan menu untuk mencatat transaksi penerimaan. 

3. Mencatat penerimaan berupa uang tunai 

4. Mencatat penerimaan berupa cek 

5. Memeriksa jurnal transaksi penerimaan 

Lingkup materi kegiatan belajar ini meliputi:  
 

1. Pengertian Transaksi Penerimaan 

2. Menu untuk Mencatat Transaksi Penerimaan 

3. Mencatat Penerimaan Berupa Uang Tunai 

4. Mencatat Penerimaan Berupa Cek 

5. Jurnal Trasaksi Penerimaan 
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1. Pengertian Transaksi Penerimaan  

Pendapatan perusahaan jasa diperoleh dari hasil penjualan jasa atau 
pelayanan jasa kepada pelanggan. Jadi yang dimaksud dengan transaksi 
penerimaan disini adalah penerimaan pendapatan dari hasil pelayanan 
jasa kepada pelanggan. Penerimaan pendapatan ini dapat berupa:  

a. Uang tunai (disimpan di perusahaan)  
b. Cek  (disetor ke bank) 

Dalam kegiatan belajar 6 ini akan dijelaskan bagaimana pencatatan 
penerimaan dengan kedua cara tersebut di atas bila dikerjakan dalam 
program MYOB. 

 

2. Menu untuk Mencatat Transaksi Penerimaan  

MYOB menyediakan menu Command Centre Banking – Receive Money 

untuk mencatat transaksi penerimaan berupa kas atau berupa cek. 

 

Gambar: 2. 64 Menu untuk mencatat transaksi penerimaan 

Banking  > Receive Money 

 

3. Mencatat Penerimaan Berupa Uang Tunai 

Untuk mencatat penerimaan berupa uang tunai MYOB menggunakan menu 
yang Command Centre Banking – Receive Money,  untuk kolom Deposit to 
Account diisi dengan akun cash on hand atau dalam kasus Renata Interior 
Designer ini adalah Cash Drawer. 
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Langkah-langkah penerimaan berupa uang tunai (Kasus: Renata Interior 
Designer): 
 
Langkah-langkah Mencatat Penerimaan Kas berupa uang tunai (lihat Kasus 6.1 
di Lembar Kerja Peserta Didik): 
 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Receive Money. 

 

 

 

 

 

 

 

 

Gambar: 2. 65 Menu transaksi penerimaan 

2 Mengganti BCA Account menjadi Cash Drawer 

 

Gambar: 2. 66 Deposit to account Cash Drawer 
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Langkah Aktivitas-aktivitas 

3 Ketik data penerimaan kas seperti tampak pada gambar berikut 

 

Gambar: 2. 67 Data Transaksi Penerimaan tunai 

4 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final. 

 

Gambar: 2. 68 Recap jurnal penerimaan. 

5 Jika sudah benar klik OK kembali ke windows receive  money 

6 Klik Record  untuk memproses jurnal 

7 Klik Cancel untuk kembali ke Menu Utama 
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4. Mencatat Penerimaan Berupa Cek 

Untuk mencatat penerimaan berupa uang tunai MYOB menggunakan menu 
yang Command Centre Banking – Receive Money,  untuk kolom Deposit to 
Account diisi dengan akun cash in bank atau dalam kasus Renata Interior 
Designer ini adalah BCA Account. 

Langkah-langkah Mencatat Penerimaan Kas berupa cek: 
 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Receive Money. 

 

 

 

 

 

 

 

 

Gambar: 2. 69 Menu Banking – Receive Money 

2 Mengganti Cash Drawer menjadi BCA Account 

 

Gambar: 2. 70 Deposit to account BCA Account 
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Langkah Aktivitas-aktivitas 

3 Isi data penerimaan kas seperti tampak pada gambar berikut: 

 

Gambar: 2. 71 Data transaksi penerimaan cek 

4 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final 

 

Gambar: 2. 72 Recap jurnal penerimaan cek 

5 Jika sudah benar klik OK kembali ke windows  Rereive Money. 

6 Klik Record  untuk memproses jurnal 

7 Klik Cancel untuk kembali ke Menu Utama 

 



 

 

Direktorat Pembinaan SMK (2013) 
108 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 6

 

5. Jurnal Transaksi Penerimaan 

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu 
Command Centre Banking – Transaction Journal. Kemudian tanggalnya di set 
dari 1/1/2013 – 31/1/2013. 

Langkah-langkah melihat jurnal penerimaan (Kasus: Renata Interior Designer): 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Transaction Journal 

 
Gambar: 2. 73 Menu melihat jurnal penerimaan 

2 Klik Tab Receipts dan tanggal diset 1/1/2013 s.d. 31/1/2013. Klik 
Close untuk mengakhiri. 

 
Gambar: 2. 74 Jurnal penerimaan dari kasus 1 
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c. Rangkuman 

 Yang dimaksud dengan transaksi penerimaan adalah transaksi 
penerimaan pendapatan dari hasil pelayanan jasa kepada pelanggan. 

 Penerimaan pendapatan dapat berupa uang tunai atau berupa cek. 

 Program MYOB menyediakan menu untuk mencatat kedua penerimaan 
yaitu: 

Banking > Receive Money 

 Penerimaan berupa uang tunai dicatat dengan menu Banking > Receive 
Money dan kolom Deposit to Account diisi cash on hand atau Cash 
Drawer. 

 Penerimaan berupa cek dicatat dengan menu Banking > Receive Money 
dan kolom Deposit to Account diisi cash on hand atau BCA Account. 

 Program MYOB menyediakan menu untuk melihat jurnal transaksi 
pembayaran yaitu: 

Banking > Transaction Journal > Tab Receipts > Set Date 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk menyelesaikan tugas berikut ini. 

4. Tugas 1, mencatat penerimaan berupa uang tunai. 

5. Tugas 2, mencatat penerimaan berupa cek. 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Yang dimaksud dengan transaksi penerimaan bagi perusahaan jasa 
adalah: 

a. Penjualan barang dagangan secara tunai 
b. Penerimaan piutang dari penjualan barang secara kredit. 
c. Penerimaan kas dari pemakaian supplies  
d. Penerimaan kas dari hasil penjualan supplies. 
e. Penerimaan pendapatan dari hasil penjualan jasa 

2. Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB 
adalah : 

a. Banking > Receive Payment 
b. Banking > Money In 
c. Banking > Receive Money 
d. Banking > Banking Register > Receive Money 
e. Banking Register > Receive Money 

3. Menu untuk mengentri transaksi penerimaan berupa uang tunai: 

a. Banking > Receive Payment > Deposit to Account: Cash in Bank 
b. Banking > Receive Money > Deposit to Account: Cash Drawer 
c. Banking > Money In > Deposit to Account: Cash Drawer 
d. Banking Register > Receive Money > Deposit to Account: Cash oh hand 
e. Banking Register > Receive Money > Deposit to Account: Cash on Hand 

 
4. Menu untuk mengentri transaksi penerimaan berupa cek: 

a. Banking > Receive Payment > Deposit to Account: BCA Account 
b. Banking > Money In > Deposit to Account: BCA Account 
c. Banking Register > Receive Money > Deposit to Account: BCA Account 
d. Banking > Receive Money > Deposit to Account: BCA Account 
e. Banking Register > Receive Money > Deposit to Account: BCA Account 

 
 
 
 
 

e. Tes Formatif 
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5. Jika ada transaksi penerimaan uang tunai hasil penjualan jasa sebesar Rp. 
300.000,- maka MYOB akan memproses jurnalnya: 

a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
b. Dr: Petty Cash Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
c. Dr: Sales or Fee Rp. 300.000,- Cr: Petty Cash Rp. 300.000,- 
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
e. Dr: Cash Drawer Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 

6. Jika ada transaksi penerimaan cek hasil penjualan jasa sebesar Rp. 
300.000,- maka MYOB akan memproses jurnalnya: 
a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
b. Dr: Petty Cash Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
c. Dr: Sales or Fee Rp. 300.000,- Cr: Petty Cash Rp. 300.000,- 
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
e. Dr: Cash Drawer Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 

7. Jika ada transaksi penerimaan cek dari setoran pemilik untuk tambahan 
investasi sebesar Rp. 300.000,- maka MYOB akan memproses jurnalnya: 
a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
b. Dr: Owner’s Capital Rp. 300.000,- Cr: BCA Account Rp. 300.000,- 
c. Dr: BCA Account Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
e. Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 

8. Jika ada transaksi penerimaan uang tunai dari setoran pemilik untuk 
tambahan investasi sebesar Rp. 300.000,- maka MYOB akan memproses 
jurnalnya: 

a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
b. Dr: Owner’s Capital Rp. 300.000,- Cr: BCA Account Rp. 300.000,- 
c. Dr: BCA Account Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
e. Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 

9. Sebelum me-record transaksi penerimaan, selalu dianjurkan untuk 
menekan Ctrl-R. Tujuan langkah ini adalah untuk:  

a. Menghindari kesalahan dalam pencatatan. 
b. Membetulkan jika ada kesalahan dalam pencatatan. 
c. Mengeliminir kesalahan dalam jurnal  
d. Mengecek kebenaran jurnal sebelum diproses 
e. Mengecek kebenaran jurnal sesudah diproses 

10. Dalam MYOB klik Record terhadap pencatatan transaksi berarti: 

a. Memerintahkan komputer untuk memperoses jurnalnya. 
b. Memerintahkan komputer untuk menghapus jurnalnya. 
c. Memerintahkan komputer untuk membatalkan jurnalnya. 
d. Memerintahkan komputer untuk memproses ulang jurnalnya. 
e. Memerintahkan komputer untuk memproses jurnal dan posting ke buku 

besar serta buku pembantu. 
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2. Tes Keterampilan. 

Didasarkan pada kasus 2: Rio Interior Design lihat di Lembar Kerja Peserta 
Didik, kerjakan tes ini dengan ketentuan sebagai berikut: 

 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, mengentri transaksi penerimaan berupa uang tunai. 

4. Tugas 2, mengentri transaksi penerimaan berupa cek. 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 e 
2 c 
3 b 
4 d 
5 e 
6 a 
7 c 
8 e 
9 d 
10 e 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

f. Kunci Jawaban Tes Formatif 
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2. Kunci Tes Keterampilan 

 
 

Gambar: 2. 75 Jurnal penerimaan dari Kasus 2 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18 
 
Kasus 6.1. Renata Interior Designer 

Dengan menggunakan program MYOB versi18, catat transaksi berikut ini.  

Transaksi penerimaan kas (dicatat sebagai Cash Drawer) 

Date Transaction  Tax Details 

12/1/14 Pemilik menyetorkan dana seb. 
Rp. 10.000.000,- ke kas 
perusahaan. 

N-T CR-05 
Payment method: 
cash 
Memo: Capital 
contribution 

 
Tabel: 2- 12 Transaksi penerimaan kas dari kasus 1. 

Transaksi penerimaan dari penjualan jasa  (jumlah sudah termasuk PPN 10%).   

Date Transaction  Tax Details 

29/1/13 Project Sales     Rp.  42.350.000,-  
Consultation     Rp.     9.350.000,- 

PPN 
PPN 
 

 
CR-01 

 
Tabel: 2- 13 Transaksi penerimaan cek dari kasus 1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

g. Lembar Kerja Peserta Didik 
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Kasus 6.2. Rio Interior Design 
Dengan menggunakan program MYOB versi18, catat transaksi berikut ini.  

Transaksi penerimaan kas (dicatat sebagai Cash Drawer) 

Date Transaction  Tax Details 

12/1/14 Pemilik menyetorkan dana seb. 
Rp. 10.000.000,- ke kas 
perusahaan. 

N-T CR-05 
Payment method: 
cash 
Memo: Capital 
contribution 

 

Tabel: 2- 14 Transaksi penerimaan kas dari kasus 2. 

 
Transaksi penerimaan penjualan jasa (jumlah sudah termasuk PPN 10%).   

Date Transaction  Tax Details 

15/1/14 Menerima Rp. 13.200.000,- dari 
hasil penjualan jasa 

PPN CR-01 
Payment Method: 
Cheque 
Memo: Project sale 

17/1/14 Menerima Rp. 18.150.000,- dari 
hasil penjualan jasa 

PPN CR-02 
Payment Method: 
Cheque 
Memo: Project sale 

24/1/14 Menerima Rp. 2.750.000,- dari 
hasil penjualan jasa konsultasi 

PPN CR-03 
Payment method: 
Cheque 
Memo: 
Consultation 

26/1/14 Menerima Rp. 11.000.000,- dari 
hasil penjualan jasa 

PPN CR-04 
Payment method: 
cheque 
Memo: Project sale 

28/1/14 Menerima Rp. 4.400.000,- dari 
hasil penjualan jasa konsultasi 

PPN CR-06 
Payment method: 
cheque 
Memo:  
Consultation 

29/1/14 Menerima Rp. 2.200.000,- dari 
hasil penjualan jasa konsultasi 

PPN CR-07 
Payment method: 
cheque 
Memo:  
Consultation 

 

Tabel: 2- 15 Transaksi penerimaan cek dari kasus 2. 
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b. Uraian Materi 

KEGIATAN BELAJAR 7 

MENCATAT ENTRI PENYESUAIAN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan 

belajar ini diharap-kan peserta didik dapat:  

1. Menjelaskan pengertian jurnal penyesuaian 

2. Menunjukkan menu untuk mencatat entri penyesuaian  

3. Mencatat entri penyesuaian 

4. Memeriksa entri penyesuaian 

Lingkup materi kegiatan belajar ini meliputi: 

1. Pengertian entri penyesuaian 

2. Menu untuk Pencatatan entri penyesuaian 

3. Pencatatan entri penyesuaian 

4. Pemeriksaan jurnal penyesuaian 



 

  

Direktorat Pembinaan SMK (2013) 
119 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 7

 

1. Pengertian Entri Penyesuaian 

Saldo-saldo akun pada akhir periode masih bersifat sementara belum 
menunjukkan jumlah yang sesungguhnya, termasuk pada akun-akun 
pendapatan dan beban. Hal ini terjadi karena selama berjalannya waktu telah 
terjadi perubahan, tetapi perubahan itu belum dicatat.  

Contoh: 

a. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest 
Income sejumlah tertentu dan Bank Charge yang harus dibayar sejumlah 
tertentu pula dan ini belum ada pencatatannya. 

b. Persediaan Office Supplies dan Photograph Supplies selama bulan januari 
telah terjadi pemakaian tetapi transaksi ini belum dicatat. 

c. Aset tetap, selama bulan Januari telah digunakan dan ini ada beban 
depresiasi yang harus diperhitungkan dan ini akan menambah nilai 
akumulasi depresiasinya. 

d. Beban yang ditangguhkan, seperti beban gaji bulan Januari yang akan 
dibayarkan pada tanggal awal Pebruari. Dan lain-lainnya. 

Contoh catatan-catatan (a, b, c, d) tersebut di atas merupakan entri 
penyesuaian yang akan dijadikan sebagai dasar pencatatan jurnal 
penyesuaian. Jadi entri penyesuaian adalah catatan-catatan pada akhir 
periode yang akan dijadikan dasar pembuatan jurnal penyesuaian agar 
saldo akhir akun-akun sesuai dengan saldo yang sesungguhnya. 

2. Menu untuk Pencatatan Entri Penyesuaian 

MYOB menyediakan menu Command Centre Accounts – Record Journal Entry 
untuk mencatat entri penyesuaian. 

 

Gambar: 2. 76 Menu untuk pencatatan entri penyesuaian 

Account  > Record Journal Entry 
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3. Pencatatan Entri Penyesuaian 

Agar saldo-saldo akun pada akhir periode menunjukkan jumlah saldo yang 
sesungguhnya, maka perlu inventarisasi entri penyesuaian pada setiap akhir 
bulan/periode. Berdasarkan entri penyesuaian yang telah dikumpulkan maka 
selanjutnya diadakan penyesuaian ke dalam jurnal umum. 

Langkah-langkah mencatat entri penyesuaian. 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Banking, Record Journal Entry. 

 

Gambar: 2. 77 Langkah 1, klik account dan record Journal entry 

2 Mencatat data penyesuaian ke dalam Jurnal Umum seperti tampak 

pada gambar berikut ini. 

 

Gambar: 2. 78 Pencatatan entri penyesuaian. 
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3 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final. 

 

Gambar: 2. 79 Recap Jurnal penyesuaian 

4 Jika sudah benar klik OK kembali ke window  Record Journal Entry. 

5 Klik Record  untuk memproses jurnal 

6 Klik Cancel untuk kembali ke Menu Utama 
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4. Pemeriksaan Jurnal Entri Penyesuaian 

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu 
Command Centre Accounts – Transaction Journal. Kemudian tanggalnya di set 
dari 1/1/2013 – 31/1/2013. 

Langkah-langkah melihat jurnal penyesuaian (Kasus: Renata Interior Designer): 

Langkah Aktivitas-aktivitas 

1 Klik Command Centre Account dan Transaction Journal. 

 

Gambar: 2. 80 Menu memeriksa jurnal penyesuaian 

2 Klik Tab General dan tanggal diset dari 1/1/2013 s.d. 31/1/2013 

 

Gambar: 2. 81 Jurnal penyesuaian Kasus 1 

3 Klik Close untuk menutup 
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c. Rangkuman 

 Entri penyesuaian adalah catatan-catatan pada akhir periode yang akan 

dijadikan dasar pembuatan jurnal penyesuaian agar saldo akhir akun-

akun sesuai dengan saldo yang sesungguhnya. 

 Akun-akun yang terkait dengan penyesuaian biasanya adalah: 

o Cash in Bank, atas dasar laporan Rekening Koran 

o Persediaan Supplies 

o Depresiasi Aset tetap dan akumulasi depresiasinya 

o Beban-beban yang masih harus dibayar atau telah dibayar di muka 

o Pendapatan diterima di muka atau masih harus diterima. 

 Menu untuk mencatat entri penyesuaian adalah: 

Command Centre Account  > Record Journal Entry 

 Menu untuk memeriksa jurnal penyesuaian adalah: 

Command Centre Accounts – Transaction Journal 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk mencatat entri penyesuaian pada akhir periode 
akuntansi. 
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Tes Formatif meliputi dua kemampuan, yaitu: 

• Test Pengetahuan dan 
• Tes Keterampilan 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Pencatatan entri penyesuaian diperlukan agar : 
a. Saldo akun-akun menunjukkan jumlah yang sesuai. 
b. Saldo akun-akun menunjukkan jumlah yang seimbang 
c. Saldo akun-akun menunjukkan jumlah yang sama. 
d. Saldo akun-akun menunjukkan jumlah yang sesungguhnya. 
e. Saldo akun-akun menunjukkan jumlah yang setara. 

2. Langkah untuk mengentri transaksi penyesuaian: 
a. Account > Record Journal Entry  
b. Account > Memorial Record Entry 
c. Account > General Journal Entry 
d. Account > Memorial Journal Entry 
e. Account > Record Journal Memorial 

3. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest 
Income dan Bank Charge sejumlah tertentu. Transaksi ini akan berakibat 
penyesuaian terhadap akun: 
a. Bank Loan 
b. Account Payable 
c. Expense 
d. Cash in Bank 
e. Income 

4. Selama periode akuntansi telah terjadi pemakaian supplies tetapi belum 
diadakan pencatatan. Transaksi ini akan berakibat penyesuaian terhadap 
akun-akun: 
a. Dr: beban supplies dan Cr: Persediaan barang 
b. Dr: Persediaan supplies dan Cr: Persediaan barang 
c. Dr: Beban supplies dan Cr: Persediaan Supplies 
d. Dr: Beban supplies dan Cr: Beban operasional 
e. Dr: Beban operasional dan Cr: Persediaan supplies 

 

 

 

e. Tes Formatif 
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5. Penggunaan aset tetap dalam kegiatan operasi pada akhir periode akan 
menyebabkan penyesuaian terhadap akun-akun: 
a. Dr: Akun aset tetap dan Cr: Depresiasi aset tetap 
b. Dr: Akun aset tetap dan Cr: Akum. depresiasi aset tetap 
c. Dr: Depresiasi aset tetap dan Cr: beban operasi 
d. Dr: Akum. depresiasi aset tetap dan Cr: beban operasi 
e. Dr: Depresiasi aset tetap dan Cr: Akum. depresiasi aset tetap. 

6. Beban salary bulan Januari akan dibayarkan di awal Pebruari. Transaksi 
ini akan berakibat penyesuaian terhadap akun-akun: 
a. Dr: Beban salary dan Cr: Utang beban 
b. Dr: Beban operasi dan Cr: Utang salary 
c. Dr: Beban salary dan Cr: beban operasi 
d. Dr: Beban salary dan Cr: Utang salary 
e. Dr: Beban operasi dan Cr: Utang operasi  

7. Pada bulan Agustus dibayar premi asuransi selama satu tahun dan dicacat 
sebagai beban. Transaksi ini akan berakibat penyesuaian terhadap akun-
akun:  
a. Dr: Insurance dan Cr: Prepaid Insurance 
b. Dr: Insurance dan Cr: Prepaid expense 
c. Dr: Prepaid Insurance dan Cr: Prepaid expense 
d. Dr: Prepaid expense dan Cr: Insurance 
e. Dr: Prepaid Insurance dan Cr: Insurance 

8. Pada bulan September dibayar sewa toko selama satu tahun dan dicacat 
sebagai aset. Transaksi ini akan berakibat penyesuaian terhadap akun-
akun: 
a. Dr: Rent dan Cr: Prepaid Rent 
b. Dr: Rent dan Cr: Prepaid expense 
c. Dr: Prepaid Rent dan Cr: Prepaid expense 
d. Dr: Prepaid expense dan Cr: Rent 
e. Dr: Prepaid Rent dan Cr: Rent 

9. Sebelum me-record entri penyesuaian, selalu dianjurkan untuk menekan 
Ctrl-R. Tujuan langkah ini adalah untuk:  
a. Menghindari kesalahan dalam pencatatan. 
b. Membetulkan jika ada kesalahan dalam pencatatan. 
c. Mengeliminir kesalahan dalam jurnal  
d. Mengecek kebenaran jurnal sebelum diproses 
e. Mengecek kebenaran jurnal sesudah diproses 

10. Langkah untuk memeriksa jurnal penyesuaian: 
a. Account > Journal Transaction  
b. Account > Record Transaction 
c. Account > General Transaction 
d. Account > Memorial Transaction 
e. Account > Transaction Journal  
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2. Tes Keterampilan. 

 
Kasus 2: Perusahaan jasa Rio Interior Design 
(Lihat di Lembar Kerja Peserta Didik) 

 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan 
oleh peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan 
hasil pekerjaannya dalam bentuk file. 

3. Tugas yang harus diselesaikan: mencatat entri penyesuaian 
pada tanggal 31/1/2014. 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 d 
2 a 
3 d 
4 c 
5 e 
6 d 
7 d 
8 a 
9 d 
10 e 

 
2. Kunci Tes Keterampilan 

 
 
Gambar: 2. 82 Jurnal penyesuaian Kasus 2 

f. Kunci Jawaban Tes Formatif 
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Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18. 
 
Kasus 7.1. 

Perusahaan jasa Renata Interior Designer 
Entri Penyesuaian per 31 Januari 2013  

Date Descriptions Tax Details 

 
31/1/13 
 
 
 
 
 
 
 
 
 

 
Rekening Koran per 31 Jan. ‘13 
Interest Revenue       Rp. 125.000,- 
Bank Charges            Rp.   65.000,- 

 
N-T 

 
GJ-112 
Memo: 
Adjustment 
 
 
 
 
 
 
 

Persediaan Supplies per 31 Jan. 2013 
Office Supplies           Rp. 4.000.000,- 
Photograp. Supplies   Rp. 8.000.000,- 

N-T 

Penyusutan Aset tetap untuk Jan. 2013:  
Prof. Equipment :        Rp. 292.000,- 
Furniture & Fixtures    Rp. 265.000,-  
Computer Equipment  Rp. 600.000,- 

N-T 

Gaji Karyawan bulan Jan’13 akan dibayar 
pada awal Pebruari’13 sebesar.                    
Rp. 6.000.000,- 

N-T 

 
Tabel: 2- 16 Entri Penyesuaian Kasus 1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

g. Lembar Kerja Peserta Didik 
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Kasus 7.2. 

Perusahaan jasa Rio Interior Design 
Entri Penyesuaian per 31 Januari 2014 

Date Descriptions Tax Details 

31/1/14 Rekening Koran per 31 Januari ‘14 
- Interest Revenue         Rp. 125.000,- 
- Bank Charges              Rp. 65.000,- 

N-T RK-112 
Memo: 
Adjustment 
 

31/1/14 Persediaan Supplies: 
-Office Supplies             Rp. 4.000.000,- 
-Photography Supplies   Rp. 8.000.000,- 

N-T GJ 01 
Memo: 
Adjustment 
 

31/1/14 Penyusutan Aset tetap untuk bulan Januari 
2014:  
Prof. Equipment :           Rp. 292.000,- 
Furniture & Fixtures       Rp. 265.000,-  
Computer Equipment     Rp. 600.000,- 

N-T GJ 02 
Memo: 
Adjustment 
 

31/1/14 Gaji Karyawan bulan Jan’14 akan dibayar 
pada awal Pebruari’14 Sebesar.  
Rp. 6.000.000,- 

N-T GJ 03 
Memo: 
Adjustment 
 

 

Tabel: 2- 17 Entri Penyesuaian Kasus 2 
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b. Uraian Materi 

KEGIATAN BELAJAR 8 

MENAMPILKAN LAPORAN 

KEUANGAN 

 

 

 

 

 

 

 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan 
belajar ini diharap-kan peserta didik dapat:  

1. Menjelaskan pengertian laporan keuangan. 

2. Menguraikan jenis-jenis laporan keuangan. 

3. Menunjukkan menu untuk penyusunan laporan keuangan 

4. Menyiapkan laporan Laba-Rugi 

5. Menyiapkan laporan Neraca 

6. Menyiapkan Laporan Arus Kas 

7. Menyiapkan laporan Lainnya. 

Lingkup materi kegiatan belajar ini meliputi: 

1. Pengertian Laporan Keuangan 

2. Jenis-jenis Laporan Keuangan 

3. Menu untuk Penyusunan Laporan Keuangan 

4. Penyusunan Laporan Laba-Rugi 

5. Penyusunan Laporan Neraca 

6. Penyusunan Laporan Arus Kas 

7. Penyusunan Laporan Lainnya. 

 
 



 

 

Direktorat Pembinaan SMK (2013) 
132 

Komputer Akuntansi Jilid 1 
 

K
E

G
IA

T
A

N
 B

E
L

A
J
A

R
 8

 

1. Pengertian Laporan Keuangan 

Laporan keuangan adalah informasi finansial tentang kegiatan perusahaan dan 
hasil-hasilnya yang disusun berdasarkan standard akuntansi keuangan tertentu 
untuk suatu saat atau periode tertentu. 

Penyusunan laporan keuangan bertujuan untuk memberikan informasi tentang 
posisi keungan, kinerja, dan arus kas perusahaan yang bermanfaat bagi 
pengguna laporan, dalam rangka membuat keputusan ekonomi serta sebagai 
pertanggung-jawaban manajemen atas penggunaan sumber daya yang 
dipercayakan kepadanya. 

Program MYOB memproses laporan keuangan berdasarkan data akuntansi 
yang telah dientri ke dalam komputer, sepanjang data yang dientri adalah data 
yang benar maka laporan keuangan yang akan dihasilkan juga akan benar. 

2. Jenis-jenis Laporan Keuangan  

Laporan keuangan yang biasa disusun oleh pihak manajemen perusahaan 
adalah: 

a. Laporan Laba-Rugi; adalah suatu ikhtisar pendapatan dan beban dari 
sebuah perusahaan dalam satu periode akuntansi. 

b. Neraca; merupakan daftar seluruh aset, utang, dan modal pemilik dari suatu 
jangka waktu tertentu (satu periode akuntansi). 

c. Laporan perubahan modal; adalah laporan yang menyajikan ikhtisar 
perubahan yang terjadi dalam modal pemilik suatu jangka waktu tertentu 

d. Laporan Arus Kas, merupakan laporan yang memperlihatkan pengaruh dan 
aktifitas operasi, pendanaan, dan investasi perusahaan terhadap arus kas 
selama periode akuntansi tertentu. 

e. Catatan atas Laporan Keuangan, yaitu laporan lain sebagai bahan 
pendukung laporan yang disebutkan di atas. 
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3. Menu untuk Penyusunan Laporan Keuangan  

MYOB menyediakan fasilitas menu yang berfungsi untuk menyusun berbagai 
laporan yang diinginkan: Reports > Index to Reports 

 

Gambar: 2. 83 Menu Report 

MYOB menyediakan fasilitas menu yang berfungsi untuk menyusun laporan 
Laba-Rugi, Neraca, dan Jurnal Umum: 

Reports > Index to Reports > Accounts 

 

Fasilitas menu yang berfungsi untuk menyusun laporan Arus kas, Jurnal 
Penerimaan Kas dan Jurnal Pengeluaran Kas: 

Reports > Index to Reports > Banking 

 

4. Penyusunan Laporan Laba-Rugi 

Langkah-langkah Menampilkan Laporan Laba-Rugi 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

2 Klik Accounts, Profit and Loss [Accrual]  dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display. 
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Langkah Aktivitas-aktivitas 

 
Gambar: 2. 84 Langkah menyiapkan laporan Laba-Rugi 

4 Laporan Laba-Rugi ditampilkan seperti berikut ini. Klik Close     
untuk mengakhiri. 

 
Gambar: 2. 85 Laporan Laba Rugi Kasus 1 
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5. Penyusunan Laporan Neraca 

Langkah-langkah Menampilkan Laporan Neraca 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

2 Klik Accounts, Standard Balance Sheet  dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display. 

4 Laporan Neraca ditampilkan seperti berikut ini. Klik Close untuk 
mengakhiri. 

 
Gambar: 2. 86 Langkah menyiapkan laporan Neraca 

5  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 87 Laporan Neraca Kasus 1 
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6. Penyusunan Laporan Arus Kas 

Langkah-langkah Menampilkan Laporan Arus Kas 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

2 Klik Banking, Statement of Cash Flow dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display. 

 
Gambar: 2. 88 Langkah menyiapkan laporan Arus Kas. 

4 Laporan Arus Kas ditampilkan seperti berikut ini. Klik Close untuk 
mengakhiri. 

 
Gambar: 2. 89 Laporan Arus Kas Kasus 1 
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7. Penyusunan Laporan Lainnya 

Laporan lain yang akan diproses adalah: 

 Jurnal Pengeluaran Kas 

 Jurnal Penerimaan Kas 

 Jurnal Umum 

a. Langkah-langkah Menampilkan Jurnal Pengeluaran Kas 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

 
Gambar: 2. 90 Menu Report 

2 Klik Banking, Cash Disbursment dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display. 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 91 Langkah menyiapkan Jurnal Pengeluaran 
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Langkah Aktivitas-aktivitas 

Jurnal Pengeluaran Kas ditampilkan seperti berikut ini. Klik Close 

untuk mengakhiri. 

 
Gambar: 2. 92 Jurnal Pengeluaran Kasus 1 
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b. Langkah-langkah Menampilkan Jurnal Penerimaan Kas 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

2 Klik Banking, Cash Receipt dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display. 

 

 

4 Jurnal Penerimaan Kas ditampilkan seperti berikut ini. Klik Close 
untuk mengakhiri. 

 
Gambar: 2. 93 Jurnal Penerimaan Kas Kasus 1 
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c. Langkah-langkah Menampilkan Jurnal Umum 

Langkah Aktivitas-aktivitas 

1 Klik Reports, kemudian Klik Index to Reports. 

2 Klik Accounts, General Journal dan Customise. 

3 Tentukan periode transaksi dan kemudian klik Display.  

 
Gambar: 2. 94 Langkah menyiapkan Jurnal Umum 

4 Jurnal Umum ditampilkan seperti berikut ini. Klik Close untuk 
mengakhiri. 

 
Gambar: 2. 95 Jurnal Umum Kasus 1 
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c. Rangkuman 

• Laporan keuangan adalah informasi finansial tentang kegiatan perusahaan 
dan hasil-hasilnya yang disusun berdasarkan standard akuntansi keuangan 
tertentu untuk suatu saat atau periode tertentu. 

• Tujuan Penyusunan laporan keuangan memberikan informasi tentang posisi 
keuangan, kinerja, dan arus kas perusahaan yang bermanfaat bagi 
pengguna. 

• Laporan keuangan yang biasa diproses perusahaan  antara lain Laporan 
Laba-Rugi, Laporan Perubahan Modal, Neraca, Arus Kas dan Catatan atas 
Laporan Keuangan. 

• MYOB menyedia menu untuk menghasilkan berbagai jenis laporan 
keuangan: Reports > Index to Reports. 

• Laporan keuangan yang dapat diproses oleh MYOB antara lain Laporan 
Laba-rugi, Neraca, Arus Kas dan Laporan lainnya. 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 

kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk menyiapkan laporan keuangan antara lain: 

a. Laporan Laba-Rugi 
b. Laporan Neraca 
c. Laporan Arus Kas 
d. Laporan lainnya, yaitu Jurnal Pengeluaran Kas, Jurnal Penerimaan 

Kas dan Jurnal Umum. 
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Tes Formatif meliputi dua kemampuan, yaitu: 
• Test Pengetahuan dan 
• Tes Keterampilan 

 
 
 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Laporan keuangan adalah laporan yang bersifat finansial. Pilih mana yang 
tidak termasuk laporan keuangan di bawah ini: 

a. Laporan pemakaian supplies tiap bulan. 
b. Laporan depresiasi aset tetap perusahaan.  
c. Laporan kerusakan mobil perusahaan. 
d. Laporan bulanan penjualan jasa per wilayah. 
e. Laporan pembayaran listrik bulanan. 

2. Laporan yang menginformasikan posisi aset, kewajiban dan equitas 
perusahaan pada periode tertentu adalah: 

a. Laporan Laba-Rugi 
b. Neraca 
c. Laporan perubahan modal 
d. Arus Kas 
e. Catatan atas Laporan Keuangan 

3. Laporan yang menginformasikan ikhtisar perubahan yang terjadi dalam 
equitas pemilik suatu jangka waktu tertentu: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 

4. Laporan yang menginformasikan suatu ikhtisar pendapatan dan beban dari 
sebuah perusahaan dalam satu periode akuntansi: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 

e. Tes Formatif 
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5. Laporan yang memperlihatkan pengaruh dan aktivitas operasi, pendanaan, 
dan investasi perusahaan terhadap arus kas selama periode akuntansi 
tertentu: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 

6. Laporan yang memperlihatkan perincian persediaan supplies selama 
periode akuntansi tertentu: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 

7. Langkah untuk menampilkan laporan Laba-Rugi: 

a. Index to reports>Reports>Tab Account > Profit & Loss (Accrual) 
b. Account > Index to reports > Tab Account > Profit & Loss 
c. Reports>Tab Account>Index to reports > Profit & Loss (Accrual) 
d. Report > Account > Tab Account > Profit & Loss (Accrual) 
e. Reports>Index to reports >Tab Account >Profit & Loss (Accrual) 

8. Langkah untuk menampilkan laporan Neraca: 

a. Reports > Index to reports > Balance > Standard Balance Sheet 
b. Account > Index to reports > Standard Balance Sheet 
c. Reports > Index to reports > Standard Balance Sheet 
d. Index to reports > Reports > Standard Balance Sheet 
e. Reports>Index to reports>Tab Account>Standard Balance Sheet 

9. Langkah untuk menampilkan laporan Arus Kas: 

a. Account >Index to reports>Tab Banking>Statement of Cash Flow 
b. Banking > Index to reports > Statement of cash Flow 
c. Banking > Reports > Statement of Cash Flow 
d. Reports > Index to reports > Tab Banking > Statement of Cash Flow 
e. Banking > Statement of cash Flow 

10. Langkah untuk menampilkan Jurnal Umum: 

a. Account > Index to reports > Tab Banking > General Journal 
b. Reports > Index to reports > Tab Account > General Journal 
c. Reports > Index to reports > General Journal 
d. Reports > Reports > General Journal 
e. Reports > General Journal 
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2. Tes Keterampilan. 

Kasus 2: Perusahaan jasa Rio Interior Design 
(Lihat di Lembar Kerja Peserta Didik) 

 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file (PDF). 

3. Tugas yang harus diselesaikan: menyiapkan laporan keuangan per 
31/1/2014 yang meliputi: Laporan Laba-Rugi, Neraca, Arus Kas, 
Jurnal Pengeluaran Kas, Jurnal Penerimaan Kas dan Jurnal Umum. 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 c 
2 b 
3 c 
4 a 
5 d 
6 e 
7 e 
8 e 
9 d 
10 b 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

f. Kunci Jawaban Tes Formatif 
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2. Kunci Tes Keterampilan 

 
 

Gambar: 2. 96 Laporan Laba-Rugi Kasus 2 
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Gambar: 2. 97 Laporan Neraca Kasus 2 
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Gambar: 2. 98 Laporan Arus Kas Kasus 2 
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Gambar: 2. 99 Jurnal Pengeluaran Kas Kasus 2 
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Gambar: 2. 100 Jurnal Penerimaan Kas Kasus 2 
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Gambar: 2. 101 Jurnal Umum Kasus 2 
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g. Lembar Kerja Peserta Didik 

 
 
 
 
 
 
Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18. 
 
 

Kasus 8.1. 

Menyusun laporan keuangan untuk perusahaan jasa: 

Renata Interior Designer 

 

Laporan Keuangan: 

 Laporan Laba-rugi 

 Laporan Neraca 

 Laporan Arus Kas 

 
Jurnal Transaksi: 

 Jurnal Pengeluaran Kas 

 Jurnal Penerimaan Kas 

 Jurnal Umum 

 

 
Kasus 8.1. 

Menyusun laporan keuangan untuk perusahaan jasa: 

Renata Interior Designer 

 

Laporan Keuangan: 

 Laporan Laba-rugi 

 Laporan Neraca 

 Laporan Arus Kas 

 
Jurnal Transaksi: 

 Jurnal Pengeluaran Kas 

 Jurnal Penerimaan Kas 

 Jurnal Umum 
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KEGIATAN BELAJAR 9 

MEMBUAT FILE BACKUP 

 

 

 
 

 

 
 
 

 
 

 

 

 

 

 

 

 

 
 
 
 

a. Tujuan Pembelajaran 

b. Uraian Materi 

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan 
belajar ini diharap-kan peserta didik dapat:  

1. Menjelaskan pengertian File Backup 

2. Menunjukkan menu pembuatan File Backup 

3. Membuat File Backup 

4. Me-Restore File Backup  

 
 

Lingkup materi kegiatan belajar ini meliputi: 

1. Pengertian File Backup 

2. Menu untuk Pembuatan File Backup 

3. Pembuatan File Backup 

4. Restore File Backup 
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1. Pengertian File Backup 

Backup adalah membuat salinan dari file-file penting. Tujuan pembuatan file 
backup dilakukan untuk menjamin integritas atau keutuhan data ketika file 
aslinya mengalami kerusakan karena terserang virus dsb.  

Proses pembuatan file backup biasanya meminta tempat/media 
penyimpanan yang berbeda dengan media penyimpanan file asli. Jadi 
dengan adanya pembuatan file backup maka satu file yang sama 
minimal disimpan di dua media yang berbeda. 

Pada umumnya program komputer akuntansi melengkapi aplikasinya 
dengan fasilitas untuk membuat backup file termasuk program MYOB. 

 

2. Menu untuk Pembuatan File Backup 

MYOB menyediakan fasilitas menu untuk membuat file backup: 

File  > Backup 

 

 

Gambar: 2. 102 Menu membuat file backup 
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3. Pembuatan File Backup 

Hal-hal yang perlu diperhatikan dalam proses pembuatan file backup adalah: 

 Siapkan media penyimpanan yang berbeda dengan media di mana file asli 
disimpan. 

 Nama file backup. 

 File backup ini akan berbentuk ZIP file.  

Langkah-langkah pembuatan file backup. 

Langkah Aktivitas-aktivitas 

1 Klik File dan Backup. 

 

Gambar: 2. 103 Memilih menu file > Backup 

2 Menentukan pilihan Backup Company File 

 

Gambar: 2. 104 Penentuan pilihan file backup 
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Langkah Aktivitas-aktivitas 

3 Menentukan media penyimpanan dan nama file backup. 

 

Gambar: 2. 105 Penentuan media penyimpanan dan nama file backup 

4 Klik Save untuk menyimpan file backup 
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4. Me-Restore File Backup 

Hal-hal yang perlu diperhatikan dalam proses me-restore file backup adalah: 

 Menentukan nama file backup yang akan di-restore. 

 Siapkan media untuk me-restore file backup.  

 

Langkah-langkah me-restore file backup. 

Langkah Aktivitas-aktivitas 

1 Klik File dan Restore. 

 

Gambar: 2. 106 Menu untuk me-restore backup file 

2 Menentukan file yang akan di-restore dan klik Open. 

 

 

 

 

 

 

 

 

 

 

 

Gambar: 2. 107 Pilih nama backup file yang di restore 
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3 Klik Nama file yang akan di-restore dan klik Save. 

 

Gambar: 2. 108 Beri Pilih nama file restore 

4 Klik OK untuk menyimpan file yang telah di-restore. 

 

Gambar: 2. 109 Konfirmasi nama file restore 
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c. Rangkuman 

• File backup adalah file cadangan untuk menjaga integritas data ketika file 

asli mengalami kerusakan. 

• File backup biasanya disimpan di media yang lain di luar tempat 
penyimpanan file asli. 

• Menu untuk membuat file backup adalah: 

File > Backup 

• File backup ini berbentuk ZIP file. 

• Restore adalah membuka kembali file backup ke dalam bentuk file aslinya. 
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d. Tugas 

Kerjakan tugas-tugas berikut ini ! 
 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses 
pemecahan kasus dapat dilakukan melalui diskusi kelompok. 

3. Didasarkan pada Kasus Renata Interior Designer peserta didik 
ditugaskan untuk membuat file backup yang diberi nama: RID-Suyono 
Backup dan disimpan di My Document/Backup 

4. Me-restore file backup yang telah dibuat. 
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Tes Formatif meliputi dua kemampuan, yaitu: 
• Test Pengetahuan dan 
• Tes Keterampilan 

 
 
 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Langkah untuk membuat backup file: 
a. File > Backup > Klik opsi backup > Ketik nama file > Save 
b. Backup > Klik opsi backup > Ketik nama file > Save 
c. Backup > File > Klik opsi backup > Ketik nama file > Save 
d. File > Klik opsi backup > Backup > Ketik nama file > Save 
e. File > Backup > Ketik nama file > Save 

2. Backup file merupakan ZIP file artinya: 
a. Mempunyai size yang sama dengan file aslinya 
b. Mempunyai size yang lebih besar dengan file aslinya 
c. Mempunyai size yang lebih kecil dengan file aslinya 
d. Mempunyai fungsi yang tidak sama dengan file aslinya 
e. Tidak ada perbedaan dengan file aslinya 

3. Alasan perlunya pembuatan backup file: 
a. Kekuatan data 
b. Kekurangan data 
c. Kelebihan data 
d. Integritas data  
e. Kelemahan data 

4. Langkah untuk me-restore backup fle: 
a. File > Backup > Pilih Bacup file > Open > Ketik nama file > Save 
b. File>Pilih Bakcup file> Restore > Open > Ketik nama file > Save 
c. File > Restore > Open > Ketik nama file > Save 
d. File >Restore > Pilih Bacup file > Save > Ketik nama file > Open 
e. File >Restore > Pilih Bacup file > Open > Ketik nama file > Save 

5. Dalam restore file, alasan dianjurkannya memberikan nama file yang lain 
dari nama file aslinya:  
a. Agar tidak terjadi file kembar 
b. Agar nama file lebih bervariasi 
c. Agar tidak terjadi tumpang-tindih (replace) file aslinya. 
d. Agar tidak terjadi gabungan file 
e. Agar tidak terjadi dua file yang berbeda nama tetapi isinya sama. 

 

e. Tes Formatif 
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2. Tes Keterampilan. 

Kasus 2: Perusahaan jasa Rio Interior Design 
(Lihat di Lembar Kerja Peserta Didik) 
 

Instruksi: 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file (PDF). 

3. Tugas yang harus diselesaikan adalah membuat backup file untuk hasil 
pemecahan kasus 2 dan kemudian me-restore kembali backup file 
tersebut di folder tertentu. 
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Kunci Jawaban Tes Formatif ini meliputi: 

 Kunci Test Pengetahuan dan 

 Kunci Tes Keterampilan 

 

1. Kunci Tes Pengetahuan 

 
Soal No. Jawaban 

1 a 
2 c 
3 d 
4 e 
5 c 

 
2. Kunci Tes Keterampilan 

 

Gambar: 2. 110 File backup Kasus 2 

f. Kunci Jawaban Tes Formatif 
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Gambar: 2. 111 File Restore Kasus 2 
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g. Lembar Kerja Peserta Didik 

 
 
 
 
 
 
Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di 
komputer melalui program MYOB versi 18. 
 
Kasus 8.1. 

Membuat File Backup dan Restore: 

Renata Interior Designer 

 

File Backup: 

 RID-Suyono Backup 

 
Restore File: 

 RID-Suyono 

 

 
Kasus 8.2. 

Membuat File Backup dan Restore: 

Rio Interior Design 

 

File Backup: 

 RIOD-Suyono Backup 

 
Restore File: 

 RIOD-Suyono 
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Evaluasi terhadap sikap (Attitude Skill). 

1. Teknik   : observasi 
2. Bentuk instrumen : lembar observasi  
3. Aspek-aspek  : Motivasi Internal, Kejujuran, Disiplin, Tanggung  

  jawab, Santun, Responsif, Proaktif. 
4. Instrumen  : 

 

LEMBAR OBSERVASI 

Mata Pelajaran : Komputer Akuntansi 
Kelas/ Semester : XI /1 
Materi Pokok : Membuat file data bisnis. 
Tanggal  : …………….. 

 

No. Nama Peserta Didik 

Aspek penilaian 

M
o

ti
v
a
s
i 

In
te

rn
a

l 
K

e
ju

ju
ra

n
 

D
is

ip
lin

 

T
a

n
g

g
u
n

g
ja

w
a

b
 

S
a

n
tu

n
 

R
e

s
p

o
n
s
if
 

P
ro

a
k
ti
f 

K
e

p
e

d
u

lia
n
 

N
ila

i 
R

e
ra

ta
 

          

1           

2           

3           

4           

5           

6           

7           

8           

Dst           

 
Petunjuk pensekoran: 

 
Skor 4 = selalu, apabila selalu melakukan sesuai pernyataan 
Skor 3 = sering, apabila sering melakukan sesuai pernyataan dan 

kadang-kadang tidak melakukan 
Skor 2 = kadang-kadang, apabila kadang-kadang melakukan dan 

sering tidak melakukan 
Skor 1 = tidak pernah, apabila tidak pernah melakukan 
   

BAB III 

EVALUASI 

A. Attitude Skills 
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Evaluasi terhadap kemampuan kognitif. 

1. Teknik : Tes; 
2. Bentuk instrumen : Uraian. 
3. Kisi-kisi :  

 

No. Indikator Nomor soal 

1. Menyiapkan data awal 1,2 
2. Membuat daftar akun 3 
3. Menyesuaikan pajak 4 
4. Meng-entry saldo awal 5 
5. Mencatat Kas Keluar 6 
6. Mencatat Kas Masuk 7 
7. Mencatat entri penyesuaian 8 
8. Menampilkan laporan keuangan 9 
9. Membuat backup file 10 

 
4. Soal-soal : 

 
Soal 1. 

Sebutkan minimal 3 (tiga) keuntungan yang bisa diperoleh dengan 
adanya komputerisasi data akuntansi menggunakan MYOB Accounting? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 
Soal 2. 

Data apa saja yang perlu diisi dalam menentukan periode akuntansi pada  
pembuatan data akuntansi baru pada MYOB Accounting? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 

B. Kognitif Skills 
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Soal 3 

Tentukan nomor kategori akun-akun berikut pada MYOB Accounting? 
 
 

 
 
 
 
 
 
 
 
 
 

Soal 4. 

Jenis pajak yang mana yang identik dengan PPN (Pajak Pertambahan 
Nilai) pada MYOB Accounting? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

Soal 5. 

Dalam proses pencatatan saldo awal akun pada MYOB Accounting, 
terjadi kondisi dimana Amount left to be allocated menunjukkan angka 
(minus) – Rp. 550.000 atau (Rp.550.000,-) ? Apa artinya kondisi ini: 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

Soal 6. 

Jelaskan fungsi modul Banking > Spend Money  pada MYOB 
Accounting? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 

KATEGORI AKUN NOMOR 

Expense ………… 

Cost of Sales ………… 

Liability ………… 

Asset ………… 

Other Income ………… 

Equity ………… 

Income ………… 

Other Expense ………… 
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Soal 7. 

Jelaskan fungsi modul Banking > Receive Money  pada MYOB 
Accounting? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 
Soal 8. 

Jelaskan modul yang digunakan untuk mencatat jurnal penyesuaian pada 
MYOB Accounting dan data apa sajakah yang harus dipersiapkan? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 
Soal 9. 

Jelaskan menu yang digunakan untuk menampilkan laporan laba-rugi 
pada MYOB Accounting dan data apa sajakah yang harus dientri ? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

Soal 10. 

Jelaskan mengapa perlu dibuat backup file dalam komputerisasi 
akuntansi ? 
 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  

 __________________________________________________________  
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Evaluasi terhadap kemampuan psikomotorik. 

1. Teknik : Tes Praktek 
2. Bentuk instrumen : Studi Kasus. 
3. Kisi-kisi :  

 

No. Indikator Nomor soal 

1. Menyiapkan data awal 1 

2. Membuat daftar akun 2 

3. Menyesuaikan pajak 3 

4. Meng-entry saldo awal 4 

5. Mencatat Kas Keluar 5 

6. Mencatat Kas Masuk 6 

7. Mencatat entri penyesuaian 7 

8. Menampilkan laporan keuangan 8 

9. Membuat backup file 9 

 
4. Soal-soal : 

 
Informasi Umum Perusahaan  

1. Miss Lisa mendirikan sebuah usaha salon. Salon tersebut diberi nama 
“LISA BEAUTY SALON” pada tanggal 01 Desember 2010. Salon itu 
berada di Pertokoan Blok M Lt.3 A-4, Jakarta Selatan, telepon/fax 021 
222 3344. 

2. Miss Lisa memutuskan agar setiap penerimaan uang akan disetor ke 
bank pada hari yang sama, dan setiap pengeluaran di atas Rp. 
1.000.000,- menggunakan cek atas rekening perusahaan pada Bank 
BCA. 

3. Miss Lisa memutuskan mulai 1 Januari 2013 digunakan komputer 
akuntansi menggunakan MYOB Accounting v.18 dan periode akuntansi 1 
Januari - 31 Desember yang dibagi dalam 12 periode bulanan. 

4. Anda ditunjuk sebagai petugas yang bertanggung jawab di bagian 
akuntansi. Tugas anda yaitu : 

 Menyiapkan file data bisnis yang diperlukan. 

 Mengentri data transaksi keuangan setiap harinya 

 Menyiapkan laporan keuangan yang diperlukan untuk kepentingan 
manajemen  

 

 

 

 

C. Psikomotorik Skills 
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5. Jasa yang ditawarkan adalah sebagai berikut : 

 
6. Neraca Saldo per 1 Januari 2013 

 

 
 
 
 
 
 
 
 
 
 

No. Code Keterangan Harga (Rp) 

1. Paket 1 Potong rambut+cuci+blow  200.000,- 

2. Paket 2 Potong rambut+cuci+blow+pewarnaan 300.000,- 

3. Paket 3 Potong rambut+creambath+blow+vitamin 500.000,- 

4. Paket 4 Potong rambut+keriting+pewarnaan  700.000,- 

5. Paket 5 Potong rambut+rebounding+pewarnaan 800.000,- 

6. Paket 6 Perawatan kulit dan rambut Silver 1.000.000,- 

7. Paket 7 Perawatan kulit dan rambut Gold 1.500.000,- 

Nama Akun Debet (Rp.) Kredit (Rp.) 

BCA Account 60.000.000,-    

Petty Cash 5.000.000,-    

Office Supplies Inventory 1.250.000,-   

Salon Supplies Inventory 10.000.000,-    

Prepaid Rent 6.000.000,-    

Salon Equipment at Cost 50.000.000,-    

SalonEquipment Accum Dep   14.400.000,-  

Furniture and Fixtures at Cost 40.000.000,-    

Furniture and Fixtures Accum Dep   10.800.000,-  

Cash Register at Cost 14.000.000,-    

Cash Register Accum Dep   7.200.000,-  

Bankcard   5.600.000,-  

PPN Collected   5.500.000,-  

BCA Loans   10.000.000,-  

Lisa’s Capital   132.750.000,-  

Total 186.250.000,-  186.250.000,-  
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7. Transaksi yang terjadi selama bulan Desember 2013 yaitu : 
 

Tgl No bukti Transaksi 

Jan 3 KM-001 
Cash 

Menerima setoran Nona Lisa sebesar Rp 
20.000.000,- sebagai tambahan modal. 

Jan 3 KK-001 
Cek-001 

Pembelian peralatan salon untuk perawatan 
rambut  sebesar Rp 6.500.000,- 

Jan 4 KK-002 
Cek-002 

Pembelian perlengkapan salon sebesar Rp 
4.250.000,- tunai dari Wella 

Jan 4 KK-003 
Cek-003 

Pelunasan BCA Loan sebesar  Rp 10.000.000,- 
plus bunga 2% Rp. 200.000,- 

Jan 5 KM-002 
Transfer 

Penerimaan BCA Loan yang baru sebesar Rp 
50.000.000,-  

Jan 5 KM-003 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 6 untuk 3 orang  Rp 3.000.000,- plus PPN 
10% sebesar Rp. 300.000,- 

Jan 6 KM-004 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 7 untuk 2 orang  Rp 3.000.000,- plus PPN 
10% sebesar Rp. 300.000,- 

Jan 7 PC-001 Pembayaran petty cash kepada majalah Nova 
untuk pemasangan iklan mini selama 20 hari 
sebesar Rp 800.000,- 

Jan 8 KM-005 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 3 untuk 3 orang  Rp 1.500.000,- plus PPN 
10% sebesar Rp. 150.000,- 

Jan 10 KM-006 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 6 untuk 5 orang  Rp 5.000.000,- plus PPN 
10% sebesar Rp. 500.000,- 

Jan 12 KM-007 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 1 untuk 10 orang  Rp 2.000.000,- plus PPN 
10% sebesar Rp. 200.000,- 

Jan 13 KK-004 
Cek-004 

Pembayaran PPN Collected ke kantor Pajak 
sebesar Rp. 5.500.000,- 

Jan 15 KK-005 
Cek-005 

Pembelian Laptop (Salon Equipment) sebesar Rp. 
3.500.000,- 
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Tgl No bukti Transaksi 

Jan 15 KK-006 
Cek-006 

Nona Lisa mengambil kas perusahaan untuk 
keperluan pribadi Rp 2.000.000,- 

Jan 15 KM-008 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 4 untuk 15 orang  Rp 10.500.000,- plus PPN 
10% sebesar Rp. 1.050.000,- 

Jan 15 KM-009 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 7 untuk 1 orang  Rp 1.500.000,- plus PPN 
10% sebesar Rp. 150.000,- 

Jan 16 KK-007 
Cek-007 

Membayar gaji karyawan untuk periode 2-15 
Januari  2013 Rp 1.500.000,00. 

Jan 18 KM-010 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 2 untuk 5 orang  Rp 1.500.000,- plus PPN 
10% sebesar Rp. 150.000,- 

Jan 19 KK-008 
Cek-008 

Pembelian perlengkapan salon sebesar Rp 
5.000.000,- 

Jan 20 PC-002 Pembayaran petty cash untuk biaya perawatan dan 
kebersihan lingkungan seb. Rp 200.000,- 

Jan 20 PC-003 Pembayaran petty cash untuk beban: 
- Listrik  Rp. 500.000,- 
- Air  Rp. 300.000,- 
- Telepon Rp. 800.000,- 
- Laundry Rp. 200.000,- 

Jan 24 KM-011 

Cash 

Penerimaan pendapatan jasa dari pelanggan: 
- Paket 2 untuk 5 orang Rp. 1.500.000,- 
- paket 4 untuk 2 orang  Rp. 1.400.000,-  
- paket 5 untuk 3 orang  Rp. 2.400.000,-  
- plus PPN 10% sebesar Rp. 530.000,- 

Jan 28 KM-012 
Cash 

Penerimaan pendapatan jasa dari pelanggan yaitu 
paket 7 untuk 1 orang  Rp 1.500.000,- plus PPN 
10% sebesar Rp. 150.000,- 

Jan 30 KK-009 
Cek-009 

Pembayaran utang credit card (Bankcard)  Des.  
2012 sebesar Rp 5.600.000,00. 

Jan 31 KK-010 
Cek-010 

Pembayaran beban gaji karyawan periode 16-31 
Januari  2013 sebesar Rp 1.500.000,00. 

Jan 31 MM-001 Sisa perlengkapan salon seb. Rp 10.200.000,- Sisa 
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Tgl No bukti Transaksi 

perlengkapan kantor seb Rp. 500.000,- 

Jan 31 MM-002 Sewa dibayar dimuka yang telah menjadi beban 
pada bulan ini sebesar Rp 500.000,- 

Jan 31 MM-003 Penyusutan aset tetap bulan Januari 2013:  

- Salon Equipment sebesar Rp. 400.000,- 
- Furniture and Fixtures sebesar Rp. 300.000,- 
- Cash Register sebesar Rp. 200.000,- 

Jan 31 MM-004 Rekening Koran Bank BCA: 

Pembayaran administrasi bank Rp 300.000,00. 
Penerimaan bunga bank Rp 700.000,00. 
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Lisa Beauty Salon. 
Daftar Akun. 

Account No. Account Name Header Account Type 

10000 Assets H Asset 

11000 Current Assets H Asset 

11100 Cash On Hand H Asset 

11110 BCA Account  Bank 

11120 Petty Cash  Bank 

11180 Undeposited Funds  Bank 

11190 Electronic Clearing Account  Bank 

11200 Account Receivables (Net) H Asset 

11210 Account Receivable  Accounts Receivable 

11220 Allowance for Doubtful Debts  Accounts Receivable 

11300 Other Current Assets H Asset 

11310 Office Supplies Inventory  Other Current Asset 

11320 Salon Supplies Inventory  Other Current Asset 

11330 Prepaid Insurance  Other Current Asset 

11340 Prepaid Rent  Other Current Asset 

12000 Fixed Assets H Asset 

12100 Salon Equipment H Asset 

12110 Salon Equipment at Cost  Fixed Asset 

12120 Salon Equipment Accum Dep  Fixed Asset 

12200 Furniture & Fixtures H Asset 

12210 Furniture & Fixtures at Cost  Fixed Asset 

12220 Furniture & Fixtures Accum 
Dep 

 Fixed Asset 

12300 Cash Register H Asset 

12310 Cash Register at Cost  Fixed Asset 

12320 Cash Register Accum Dep  Fixed Asset 

13000 Other Assets H Asset 

13100 Goodwill  Other Asset 

20000 Liabilities H Liability 

21000 Current Liabilities H Liability 

21100 Credit Cards H Liability 

21110 Bankcard  Credit Card 

21200 Account Payable  Accounts Payable 

21310 PPN Collected  Other Current Liability 

21330 PPN Paid  Other Current Liability 

21400 Salary Payable   Other Current Liability 

21600 Customer Deposits  Other Current Liability 

21700 Other Current Liabilities  Other Current Liability 
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22000 Long-Term Liabilities H Liability 

22100 BCA Loans  Long Term Liability 

22200 Other Long-Term Liabilities  Long Term Liability 

30000 Equity H Equity 

31100 Lisa's Capital  Equity 

31200 Lisa 's Drawings  Equity 

38000 Retained Earnings  Equity 

39000 Current Year Earnings  Equity 

39999 Historical Balancing  Equity 

40000 Income H Income 

41000 Service Income  Income 

45000 Miscellaneous Income  Income 

50000 Cost of Sales H Cost of Sales 

51000 Labour  Cost of Sales 

60000 Expenses H Expense 

61100 Advertising & Promotion  Expense 

61210 Bank Charges  Expense 

61400 Depreciation Expense  Expense 

61500 Discounts H Expense 

61510 Discounts Given  Expense 

61520 Discounts Taken  Expense 

61600 Dues & Subscriptions  Expense 

61700 Equipment Rental  Expense 

61800 Insurance  Expense 

62100 Laundry  Expense 

62400 Maintenance & Cleaning  Expense 

62500 Office Supplies  Expense 

62600 Salon Supplies  Expense 

62800 Rent  Expense 

62900 Repairs  Expense 

62950 Shrinkage/Spoilage  Expense 

63010 Staff Amenities  Expense 

63030 Wages & Salaries  Expense 

63100 Telephone  Expense 

63300 Uniforms  Expense 

63410 Electricity  Expense 

63430 Water  Expense 

80000 Other Income H Other Income 

81000 Interest Income  Other Income 

90000 Other Expenses H Other Expense 

91000 Interest Expense  Other Expense 
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Kriteria Laporan keuangan yang dihasilkan hendaknya meliputi: 

1. Laporan Laba-Rugi (Accrual) untuk periode 2013 yang disusun secara 

rinci dengan format multi steps. 

2. Laporan Neraca (Standard) per 31 Januari 2013 yang disusun secara 

rinci dengan format staffel. 

3. Laporan Arus kas untuk periode 1/1/2013 s.d. 31/1/2013 yang disusun 

dengan metode tidak langsung 

 

 

 

1. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan kognitif 
yaitu 2 x Jam Pelajaran @ 45 menit.  

2. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan 
psikomotor yaitu 4 x Jam Pelajaran @ 45 menit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

D. Produk/Benda Kerja Sesuai Kriteria Standar 

E.  

E. Batasan Waktu Yang Telah Ditetapkan 

F.  
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1. Jawaban soal untuk kemampuan kognitif: 

Jawaban Soal 1 

 Proses kerja cepat. 

 Pencegahan kesalahan 

 Posting jurnal ke buku besar/buku pembantu secara otomatis. 

 Volume kerja lebih besar 

 Pencetakan laporan bisa berkali-kali. 

Jawaban Soal 2 

 Current financial year (tahun periode akuntansi). 

 Last month of financial year (bulan terakhir dari tahun periode). 

 Conversion month (Bulan konversi) 

 Number of accounting period (Jumlah periode akuntansi) 

Jawaban Soal 3 

 Expense  : 6 

 Cost of Sales : 5 

 Liability  : 2 

 Asset  : 1 

 Other Income : 8 

 Equity  : 3 

 Income  : 4 

 Other Expense : 9 

Jawaban Soal 4 

Jenis pajak yang identik dengan PPN pada MYOB Accounting: 

 GST (Goods and Services Tax) atau 

 VAT (Value Added Tax) 

Jawaban Soal 5 

Amount left to be allocated: - Rp. 550.000,- atau (Rp. 550.000) artinya 
bahwa jumlah debet  lebih kecil Rp. 550.000,- dari jumlah kredit atau 
jumlah kredit lebih besar Rp. 550.000,- dari jumlah debet. 

Jawaban Soal 6 

Modul Banking > Spend Money memberikan fasilitas untuk mencatat 

transaksi pembayaran uang tunai melalui akun-akun Cash in Bank/ Petty 
Cash/ Bankcard yang tidak ada kaitannya dengan pembelian barang 
dagangan. 

Jawaban Soal 7 

Modul Banking > Receive Money memberikan fasilitas untuk mencatat 
transaksi penerimaan uang tunai melalui akun-akun Cash in Bank/ Cash 
on Hand yang tidak ada kaitannya dengan penjualan barang dagangan. 

 

 

F. Kunci Jawaban Kognitif Skill 

G.  
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Jawaban Soal 8 

Modul yang digunakan untuk mencatat jurnal penyesuaian adalah Account 
> Record Journal Entry.  

Data yang perlu dipersiapkan adalah nomor dan nama akun-akun yang 
didebet beserta jumlahnya dan nomor dan nama akun-akun di kredit 
beserta jumlanya.  

Jawaban Soal 9 

Menu yang digunakan untuk menampilkan laporan Lab-rugi adalah Report 
> Index to Report > Tab Account > Profit and Loss [Accrual] atau 
menggunakan menu yang ada di bawah Report > Account > Profit and 
Loss [Accrual]. 

Data yang perlu dientri adalah periode akuntansi dari tanggal awal s.d. 
tanggal akhir. 

Jawaban Soal 10 

Backup file dalam komputer akuntansi perlu dibuat untuk menjaga 
keutuhan dan integritas data, apabila terjadi kerusakan pada file asli yang 
ada di komputer karena akibat terkena virus atau sebab lainnya. 
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2. Jawaban soal untuk kemampuan psikomotor 

a. Laporan Laba-Rugi: 

 

 
Gambar: 3. 1 Laporan Laba-rugi 
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b. Laporan Neraca 

 

 
Gambar: 3. 2 Laporan Neraca  
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c. Laporan Arus Kas 

 

 
Gambar: 3. 3 Laporan Arus Kas 
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Setelah Laporan Keuangan pada akhir Januari diselesaikan dan sudah dibuat 
backup file, maka proses akuntansi berikutnya akan diteruskan ke bulan 
Februari. Tugas selajutnya adalah melaksanakan pencatatan transaksi bulan 
Februari. Untuk itu tidak diperlukan lagi mengentri saldo-saldo awal akun buku 
besar atau buku pembantu secara manual seperti yang dilakukan di awal bulan 
Januari. Program MYOB akan secara otomatis mengakumulasi jumlah saldo 
dengan jumlah penambahan/ pengurangan sebagai akibat dari transaksi bulan 
Pebruari. Laporan keuangan yang nantinya akan ditampilkan di akhir Pebruari 
adalah hasil akumulasi transaksi dalam dua bulan yaitu transaksi Januari dan 
Pebruari. Demikian seterusnya sampai dengan akhir bulan Desember 2013. 

Pada akhir bulan Desember 2013 (akhir periode akuntansi) Program MYOB 
menyediakan menu untuk menutup semua akun-akun nominal (akun Laba-rugi) 
dan akan memulai dengan akun-akun riil atau neraca awal Januari 2014. Menu 
ini adalah File > Start a New Year > Start a New Financial Year .  

   

Gambar: 4. 1 Start a New Financial Year 

BAB IV 

PENUTUP 
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